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About This Guide

Introduction

This guide introduces and describes how to use the Honeywell MAXPRO® NVR application.

The MAXPRO NVR family is an unmatched suite of open, easy to use and scalable IP 
recording solutions that satisfy almost any application. The family includes Software and 
Turnkey Box NVR Solutions.

Scope

This guide describes how to use MAXPRO NVR application and it also provides information 
on the features and functionalities common to all the variants of MAXPRO NVR. The technical 
aspects of MAXPRO NVR are beyond the scope of this guide.

Intended Audience

This document is intended for the operators of MAXPRO NVR.

Structure of this Guide

The following table describes the contents of each chapter in this guide.

# Chapter Description

1 Introducing MAXPRO NVR Introduces the MAXPRO NVR system and 
types of surveillance solutions.

2 Logging On and Getting 
Started

Describes the procedure to log on and gives 
an overview of the MAXPRO NVR.

3 Monitoring a Site Describes the procedures to view live and 
recorded video and the operations you can 
perform on them.

4 Searching Recorded Video in 
MAXPRO NVR

Describes the search options available in 
MAXPRO NVR.

5 Generating Reports Describes the various reports that you can 
generate in MAXPRO NVR.

6 MAXPRO NVR Web Client Describes the procedure to log on to 
MAXPRO NVR Web Client and how to use the 
web client to access the MAXPRO NVR.

7 Using the MAXPRO NVR 
Mobile App

Describes the procedure to log on to 
MAXPRO NVR Mobile App, and how to use 
the mobile app to access the MAXPRO NVR.
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Related Documents

This document listed in the table serves as a necessary prerequisite for installing and 
configuring MAXPRO NVR. 

Typographical Conventions

This document uses the following typographical conventions:

Document title Part number Description

MAXPRO NVR Installation 
and Configuration Guide 

800-16419V5-D This document is intended for field and commissioning engineers 
and describes the procedures and guidelines for installing, 
configuring and using the MAXPRO® NVR system.

Font What it represents Example

Swiss721 BT Words or characters that you must type. The word 
“enter” is used if you must type text and then press 
the Enter or Return key.

Enter the password.

Menu titles and other items you select Double-click Open from the File menu.

Buttons you click to perform actions Click Exit to close the program.

Italic Placeholders: words that vary depending on the 
situation

user name

Cross-reference to external source Refer to the MAXPRO® NVR Installation 
and Configuration Guide.

Cross-reference within the document See Installation.
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1
Introducing MAXPRO NVR

Honeywell’s MAXPRO NVR line includes turnkey solutions—NVR (XE, SE, PE) with 8 to 64 
channels and NVR Hybrid (XE, SE, PE) with 16 to 64 channels— and software solutions that 
range from 4 to 64 channels. It supports ONVIF Profile S and PSIA interoperability standards, 
RTSP, native integration for third-party cameras—including 360° camera support—and 
encoders from Honeywell, Axis and other manufacturers, making it a truly open system. 

MAXPRO NVR provides easy to use desktop clients, web clients and mobile apps. The 
advanced IP video capabilities make MAXPRO NVRs easy-to-install with 3-clicks* to live video 
and easy-to-use with features such as Video Surround, Calendar Search, SMART VMD, 
SMART Motion Search, Multi Streaming, Status Monitoring and Auto Discovery for every day 
security users as well as advanced video surveillance users.

* - With default settings and in a local area network for specific models.

MAXPRO NVR Turnkey Boxed Solutions
Honeywell’s MAXPRO NVRs offer ideal solutions from entry to enterprise IP video surveillance 
systems. Supporting Honeywell's high definition (HD) cameras and broad integration with 
third-party IP cameras and encoders. The MAXPRO family NVRs is a powerful HD IP recording 
and security monitoring system for a variety of applications. MAXPRO NVR comes pre-
installed with the required software and pre-licensed with the required channels depending on 
the MAXPRO NVR model you purchase.

MAXPRO NVR Software Only Solution
Honeywell’s MAXPRO NVR Software solution is a flexible, scalable and open IP video 
surveillance system. Supporting Honeywell's high definition (HD) cameras and broad 
integration with third party IP cameras and encoders, the MAXPRO NVR family is a powerful, 
high definition IP recording and security monitoring system for a variety of applications. 
MAXPRO NVR Software solution ensures flexibility for end-user IT departments when 
choosing the NVR hardware to deploy and end users will find it as easy as a simple DVR to 
configure and operate. 

MAXPRO NVR Software is an open platform that supports broad third party device 
integrations with support for PSIA and ONVIF Profile S standards, real time streaming protocol 
(RTSP) standard and native device integrations. MAXPRO NVR provides easy-to- use desktop 
and web clients and mobile apps. MAXPRO NVR Software comes with all required software 
applications and a license for 4, 8, 16, 32, 64, 128 channels while allowing for up to 128 
cameras as your system grows. Minimum hardware specifications for different levels of 
recording and monitoring performance are provided for IT departments to choose the 
appropriate hardware platform for their system. This, along with quick and easy 
commissioning wizards for discovery and system configuration, makes installing HD IP 
systems quick and efficient without requiring any IP expertise. Simple and logical 
configuration pages make setup a breeze even for the novice installer. The following table 
describes the software solutions available.

MAXPRO NVR Family

The following table describes the various MAXPRO NVR Hybrid and MAXPRO NVR offerings 
that are available.



I N T R O D U C I N G  M A X P R O  N V R

MAXPRO NVR Family
1

16  MAXPRO NVR 5.0 Operator’s  Guide

MAXPRO NVR Hybrid 
XE (Xpress Edition)

MAXPRO NVR Hybrid 
SE (Standard Edition)

MAXPRO NVR Hybrid 
PE (Professional 

Edition)

MAXPRO NVR XE 
(Xpress Edition)

MAXPRO NVR SE 
(Standard Edition)

MAXPRO NVR PE 
(Professional Edition)

MAXPRO NVR 
Software

Description
Simple, affordable 

NVR Hybrid
Flexible, scalable 

NVR Hybrid
Enterprise class NVR 

Hybrid
Simple, affordable

NVR
Flexible, scalable 

NVR
Enterprise class NVR

Flexible, software 
only NVR

Channels 16 Analog or 16 IP
16 Analog and 48 IP 

or only 64 IP
16 Analog and 48 IP 

or only 64 IP
8 or 16 Up to 64 Up to 64

4, 8, 16, 32, 64 or 
128

Maximum
Frame Rate

Server hardware 
dependent-Minimum 

hardware specs 
recommended for 

various fps

at 4CIF/VGA 
IP

480 fps (16 ch IP) 1920 fps (64 ch IP) 1920 fps (64 ch IP) 480 fps 1920 fps 1920 fps

at 720p IP 480 fps (16 ch IP) 1920 fps (64 ch IP) 1920 fps (64 ch IP) 480 fps 1920 fps 1920 fps

at 1080p IP 
(4 Mbps 
bitrate)

480 fps (16 ch IP) 1280 fps (64 ch IP) 1920 fps (64 ch IP) 480 fps 1280 fps 1920 fps

at CIF or 
4CIF/D1 
Analog

480 fps CIF or 120 
fps 4CIF/D1 (16 ch 

Analog)

480 fps CIF or 120 
fps 4CIF/D1 (16 ch 

Analog)

480 fps CIF or 120 
fps 4CIF/D1 (16 ch 

Analog)

Storage
1 - 16 TB, internal 

fixed
1 - 24 TB removable 

bays
Up to 68 TB RAID 

5/6, removable bays
1 - 12 TB

internal fixed
1 - 48 TB, removable 

bays
Up to 68TB RAID 

5/6, removable bays
Server hardware

dependent

Form Factor Desktop Workstation/Server Server Desktop Workstation/Server Server
Server hardware 

dependent
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Note: The product options available in your region may vary, please contact your local
Honeywell representative for more information.

MAXPRO NVR Features

MAXPRO NVR (Turnkey NVR/Hybrid boxes - XE, SE, PE and Software only solution) offers the 
following key features that differentiate it from other IP video surveillance systems.

New features in NVR 5.0

• NVR 5.0 Installation is supported for Windows 2016 OS (Server).

Introduced the following new services 

• TrinityIntegrity Service: A service that runs in background and ensures all the 
system data is synchronized. As part of 5.0 release it includes features such as 
Delete Orphan Data and Drive Feature. See Integrity Service Settings section for 
more information.

• Trinityupdate Service: A service introduced to scale recording capacity on 
demand and to enable necessary steps required for additional recording 
services.

• NeoStorageserver3 and NeoStorageserver4: These services are to support 128 
channels in a system and starts automatically after a user crosses 64 and 96 
channels respectively. These services will stop when user deletes the cameras 
and the count goes less than <64 and <97 respectively.

Support for 128 Channel
Additional 64 channels are provided with the existing 64 channels, resulting in a total of 128 
channels in NVR Software and PE RAID System. User needs to buy license for the additional 
channels. If only Encoders are added in the system then without additional license user can 
add up to 128 Channels. However, adding additional channels depends on the type of 
encoder.

Privacy Protection Settings (GDPR Favored) 
Anonymization Support

Anonymization feature is to help the business owner to meet the EU GDPR compliance 
standards easily. The objective of this feature is to hide the identifiable personal data or 
personal identity in a video surveillance system using masking techniques. This feature is 
specific to European Union region and valid license is required to enable this feature. 

Anonymization at NVR level can be set in Configurator > Systems tab and only an 
Administrator can use this feature and grant access in User tab. This feature can also be 
enabled at camera level under Stream >Preferences tab. EquIP Series cameras are 
supported by this feature.

The Anonymization feature supports two types of masking:

• Blur: Blurs the region

• Pixelize: Pixelizes the region
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Four Eye Authentication Support

This feature is also part of Privacy Protection setting and to meet the EU GDPR compliance 
standards easily. This feature is to restrict all users in a surveillance system to perform 
Playback operation. While performing playback operation at least two people from different 
roles should authenticate. For an Administrator, user authentication is not required and can do 
any playback operation. For an operator user, a popup is displayed and an Administrator user 
or any other User with different role needs to authenticate to perform playback operation. 

In MAXPRO NVR, a check box is introduced to enable this feature in Systems tab. By default 
this check box is not selected. User need to obtain valid license to enable this feature.

The following table explains the Four Eye Authentication based on the user and roles.

Clip Export with Anonymization support: Anonymization feature is supported for both 
Playback and Clip Export operation. 

Note: If a user exports a clip with Anonymization using Clip Export option then only
WMV format is supported.

Password Complexity and Expiry Enhancements
The following are the enhancements:

• Improved change of password security by introducing complexity requirements. The 
following are the password requirements.

• The password should have a minimum length of 12 characters.

• The password should consist of at least one number, one uppercase letter and 
one special character 

• If user changes the password, it will expire for every 90 days. Earlier it was no expiry

• If user wants to set the password which should never expire then navigate to 
Configurator > Users tab. Select the Password Never Expire check box for the 
specific user.

• User is notified with the message Your Password will expire in no.of days on the top 
right corner of the screen.

• If Admin password is expired then the administrator can use the Change Password 
feature in NVR log in screen to create a new one.

User Authenticating User Valid 
Authentication

Operator Administrator Or any other user with different 
role

Yes

Operator Operator No

Operator Operator 2 Yes
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Note: Only administrator will have access to user screen and can change the password
for operator. Operator should contact administrator for changing the password
and settings.

In Upgrade Scenario
If user upgrades to NVR 5.0 then the password complexity requirements will be applicable.

In Fresh Installation Scenario

In case of Fresh Installation, the following are the recommendations:

• Only default username is displayed and the password field will be blank

• User must create new password

• In Create New Password dialog box, leave the Old Password field blanks and 
proceed.

UI Improvements
For better user experience and accessibility the following features are rearranged in Systems 
tab

• Archival Schedule

• In camera level added after 30 minutes (s) as a new entry.

• Edge Sync Settings

• Privacy Protection  Settings

Improvements in Status Monitor

• Additional status message Database Connection lost is included. This will help user 
to know the status of database connection.

• Color Indications:

• Green: Everything is Fine

• Blinking between Yellow and Green: Not Recording

• Blinking between Yellow and Red: Database Connection Lost
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System and Performance Improvements 

• There is no Metadata from 5.0 Release onwards

• No separate drive is required for Metadata

• New Recording file system with no Index files except PassIndex is introduced 
and it is for per camera and per drive

• Plug-in a new recording drive which can have recordings of another 5.0 NVR, 
and play the same recordings by adding the same Unique Number of the 
camera.

• Supports backward compatibility (5.0 version can play till 4.9 version recordings 
(With  Metadata) including 5.0 recordings). No recording loss in user’s 
perspective.

• Recording, Retrieval and Recycle features will have no dependency on index 
files.

• PassIndex only use as catalyst

• New naming convention for Segment files (Num_StartTime_EndTime)

• Access recordings directly from recording drive

• Each recording drive is self sufficient

• XML Corruption recovery

• Auto recovery of corrupted XMLs by NEO on the run

• No functionality loss

Integrity Service Settings
This is a new a service that runs in background and ensure all system data to be 
synchronized. Following are the features this service provides as part of 5.0 release.

1. Delete Orphan Data: In this feature, system will find and clean up orphan clips from file 
system or DB. Orphan data will be identified based on camera configured deletion 
settings.

2. Drive Feature: In this feature, Drive Full Scan is performed until a new fixed drive is 
detected in NVR system. Based on the scan result, data sync up or orphan data clean up 
process is initiated using the current camera configuration or if the camera is not found 
then, by default the data after 30 days will be deleted..

For Example: If NVR 1 is down due to some technical issues, then the hard disk of NVR 1 
can be used in NVR2. NVR2 initiates the scan, detects the drives and displays the 
recordings of NVR 1.

• Running on schedule base is same as windows scheduler.

• Has capability to process deleted camera’s data for Orphan deletion.

3. Schedule of when to start the service can be configured.

4. Allows Neo to recycle data first (since by default it deletes clips with retention period + 24 
hours) 

New EquIP 1080p and 4MP Camera Integration
1. Configuration is done through Honeywell proprietary ISOM APIs
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2. After integrating the new EquIP Camera, system will be able to perform the following

• H.264, H.265 and MJPEG coded support

• HTTPS support

3. New events supported: With the EquIP series camera integration the following events are 
generated.

• Abandoned Object detection

• Object Missing detected

• Trigger Line detection

The following EquIP series Camera models are supported using ISOM API’s

RTSP H.265 Support

• Any H.265 URL can be added and streamed with Generic-RTSP streamer name.

Enhancements in MAXPRO Mobile APP

• Introduced new Mobile app versions

• For Andriod: 1.3.0 (100030004)

• For IOS: 1.3.0 (100030001)

• New Supported OS: minSDKVersion = 21:

• Finger Print Authentication is supported for Android version of MAXPRO Mobile app. 
However, this feature is available on Fingerprint supported devices.

# Camera 
Model

Description Firmware Details

1 H4L2GR1V 2MP Lowlight outdoor dome Version: 1.000.0000.8, Build Date: 
2018-03-16
VA Package 
Version: 1.0.7_build20180315
ISOM Version: 1.2.1_build20180316 

2 HBL2GR1V 2MP Lowlight IR bullet

3 HCL2GV 2MP Lowlight box camera

4 H4W2GR1V 2MP WDR outdoor dome

Version: 1.000.0000.8, Build Date: 
2018-03-16
ISOM Version: 1.2.1_build20180309

5 H4W4GR1V 4MP WDR outdoor dome

6 HBW2GR1V 2MP WDR bullet, 2.7-13.5mm

7 HBW2GR3V 2MP WDR bullet, 5-60mm

8 H3W2GR1V 2MP WDR indoor dome

9 H3W4GR1V 4MP WDR indoor dome

10 HCW2GV 2MP WDR box camera

11 H2W2GR1 2MP Pancake camera
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Limitation with Privacy Protection Settings in MAXPRO Mobile App

• If Anonymization is enabled in NVR application, then user will not be able to see the 
video in MAXPRO mobile app/Web client. An error message is displayed.

• If Four Eye Authentication option is enabled in NVR application then user will not be 
able to view playback video in MAXPRO mobile app/Web client..

Grand Eye New Evolution support
EVO18 0 and EVO12

Industry Standards 
MAXPRO NVR is an open platform and supports broad third party device integrations with 
support for PSIA and ONVIF Profile S standards, Real Time Streaming Protocol (RTSP) 
standard and native device integrations.

Flexible Licensing 
MAXPRO NVR comes with all required software applications and licenses. 

Role Based Operator Privileges
MAXPRO NVR offers role-based operator privileges supporting Windows and Local users. You 
can add up to 1024 users under the Users tab.

Easy Configuration
A quick and easy 3-clicks* wizard to set up the system with auto-configuration and auto-
discovery of IP cameras, recording and monitoring configuration, makes installing HD IP 
systems quick and efficient without requiring any IP expertise. Simple and logical 
configuration pages make setup a breeze, even for the novice installer.

* - With default settings and in a local area network for specific models.

64 channel Support
MAXPRO NVR (SE, PE), Hybrid NVR (SE, PE) and Software only solution now support 64 
channels. You can connect up to 64 cameras based on your type of solution.

Auto Discovery
Discovering the IP cameras in the network is now simpler with the enhanced auto discovery 
interface. You can define the IP range to search for the cameras in the network and also 
camera credentials can be set at once for the newly discovered cameras.

MultiStream
MAXPRO NVR provides you with the flexibility to add multiple streams with different 
resolutions on a single camera. Depending on the type of camera, you can add and configure 
additional streams, define the Video Quality Settings, Recording Settings, and Stream 
Preference settings. Based on your requirements you can view or render different resolutions 
on a single camera. It also allows you to set various parameters for your recording, including 
audio.
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Multicast Support
This feature is to view the Live video continuously in VMS clients despite of any interruption in 
NVR recorders. The camera should be Multi-cast capable to use this feature. User needs to 
configure the camera for Multi-cast in NVR camera page and ensure that the network Switch is 
also Multi-cast enabled.

Third Party ONVIF Profile G supported cameras
Following new Third Party ONVIF compliance Profile-G cameras are now supported in NVR 
4.7.

MAXPRO Web Configurator
Enhanced the Web configurator user interface with new themes, for a better user experience 
while configuring the System, Server and Security configurations for Web client and mobile.

New Deletion Schedule
Introduced new deletion schedule where user can now retrieve the recordings of the last 5 
years.

GPU Rendering Support
Cost-effective enhanced HD video rendering on remote desktop clients with support for 
monitoring of up to 18 1080p HD cameras in real time (30 fps) with no-time-lapse using the 
GPU capabilities of built-in processor graphics with Intel® 4th generation processors. This 
feature allows a user to render high resolution cameras while optimizing the CPU 
consumption.

Analog Capture Card Support
MAXPRO NVR Hybrid supports an Analog Capture card through which you can manually add 
16 analog cameras. Each capture card comes with 16-channel support and allows you to 
manage the analog cameras.

User-Friendly and Feature-Rich User Interface 
The MAXPRO NVR user interface is based on Honeywell's flagship MAXPRO® VMS user 
interface which offers a feature-rich user experience. Utilization of this familiar interface allows 
for the “Learn One, Know Them All” concept that ensures familiarity across a broad range of 
Honeywell products.

MAXPRO Status Monitor
MAXPRO Status Monitor is a brand new application in the V4.0 release that helps you to 
search and monitor the NVR’s (System or Recording Engine) in the current network. You can 
monitor a single system/recording engine or multiple systems/recording engines at once. This 
application is installed along with the NVR 4.0 software only solution and can be accessed on 
the desktop.

Profile G Cameras Camera Type Firmware Details

Tyco ADCi350-B111 V3.1.0 .170215

Samsung QNO-7010R 1.04_170224

Panasonic WV-SFV631L 2.41
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You can manually add or auto search for NVRs and then connect to a single or multiple NVRs 
(System or Recording Engine) to monitor the status of various parameters. 

For a system you can monitor parameters such as CPU Consumption, Average Disk Queue 
Length, Disk Write/Read and so on, depending upon the NVR connected.

For a Recording engine you can monitor parameters such as Total FPS Received/Recorded, 
Total Bitrate Received/Recorded, Total Active Cameras and so on.

Recording and Playback Operations
MAXPRO NVR supports simultaneous recording, live and playback viewing, search and 
system management of all supported IP cameras including HD formats in a single server 
instance. 

On Demand l ive St reaming
An on edge recording facility where you can configure and store recordings at camera level. 
Later the recordings at the camera level can be synchronized back to view in NVR viewer. This 
avoids persistent stream recording. MAXPRO NVR configured as On Demand Live Streamer 
streams video from camera, only when a client request a live stream for viewing. When all the 
clients close the particular camera, then streaming from the camera is stopped.

The NVR configured as On Demand streamer supports only Sync back edge recording.On 
Demand live streaming is compatible from MAXPRO NVR Viewer, MAXPRO NVR Web Clients 
and MAXPRO NVR Mobile app clients.

In your PC, by default On demand Live Streaming registry value is set to zero (disabled). User 
needs to change the value to 1 to use this feature. Refer MAXPRO NVR Installation and 
Configuration Guide for more information.

Recording support in On Demand video Streaming: It is also an add-on for the existing 
Edge Sync Recording feature. This feature helps user to enable recording during on demand 
video streaming. A check box is introduced in Configurator > System tab to enable this 
feature. Earlier only live video was supported.

Profile-G or Edge Sync Support
Profile-G or Edge Sync feature allows you to synchronize the recordings from the camera SD 
card to NVR. Camera SD card contains recordings that are configured on demand. This 
features enables the user to playback only those recording which are saved on demand in the 
SD card. User can enable the edge syn feature in Camera page and configure the day and 
time for synchronizing in System window to get the recordings from the camera. Edge Sync 
feature is applicable only to the cameras with SD card. This feature is supported only for New 
EquIP Series model cameras.

Automatic Retry clips is an add-on for the existing Edge Sync Recording feature. This feature 
is meant to retry and download the failed clips. It allows user to configure various parameters 
in the config file to avoid clips download failure. If any clips fails to download then based on 
the user configuration auto retry feature downloads the clips to NVR. 

Refer MAXPRO NVR Installation and Configuration Guide for more information on configuring 
Automatic Retry feature.

Low bandwidth Stream Settings:
Use Low Resolution Stream: This feature is to view the low resolution video in any format of 
salvo layout. User needs to configure the low resolution (for any Primary or secondary stream) 
in MAXPRO NVR camera page. This feature is only supported for MAXPRO NVR.

Receive Only I Frame/Low Bandwidth Streaming: This feature is applicable only for the 
sites with Low bandwidth. It allows user to receive and view only I Frame considering the 
bandwidth at the site. This feature is only supported for MAXPRO NVR.
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Use Extended time Outs: This helps in increasing the default time outs for NVR connections, 
stream connections and snapshots retrieval. This feature is only supported for MAXPRO NVR.

Opt imize Stream Usage Set t ings:
Enable Stream Switch: Enable stream switch automatically switches between low and high 
resolution streams in the salvo layout based on the users selection. User should have 
minimum two streams available to use this feature. By default camera will stream in high 
resolution video in single salvo layout and the same camera when it is drag and dropped in 
multiple salvo, it streams with low resolution video. This feature is only supported for MAXPRO 
NVR.

Enriched Video Viewing Experience
MAXPRO NVR offers an enriched video viewing experience through the intuitive video 
rendering engine that optimizes CPU utilization by altering the video frame rate.

Efficient Event and Alarm Viewing Capability
MAXPRO NVR provides the ability to investigate events and alarms by simultaneously viewing 
alarm videos at various stages. For every alarm, users can view the video captured during pre-
alarm, on-alarm, and post-alarm, and also view live video from the camera which triggered the 
alarm.

Simultaneous Video Recording and Video Viewing
MAXPRO NVR supports multiple simultaneous operations such as video recording and video 
viewing or alarm monitoring on the server unit without the need for an additional workstation. 
It also provides the option of remote monitoring clients. You can view live video while 
simultaneously performing searches.

Video Motion Detection (VMD) Support
MAXPRO NVR supports both camera-based and server-based video motion detection (VMD). 
Camera-based VMD support depends on the integration method and the motion detection 
performance depends on camera analytics. Server-based VMD (SMART VMD) is supported 
for all video devices supported by NVR, and is based on Honeywell Active Alert analytics 
algorithms supporting object-based motion detection with reduced false alarms.

SMART Motion Search
SMART Motion Search feature allows you to search for a missing object by searching on 
motion in recorded video within a short span of time. This feature overcomes the traditional 
way of searching an object in recorded videos. It also provides you with before and after 
recordings of a missing object.

New EquIP Series Camera Models Support
Additional 8 new EquIP camera models are now supported (HFD6GR1, HSW2G1, HCD8G, 
HBD8GR1, H4D8GR1, HDZ302DE, HDZ302D, HDZ302DIN). In addition the following are the 
advanced features that are offered through these cameras:

• Intrusion trace (Need to purchase separate license to enable this feature in camera)

• Face Detection

• Audio Detection (For cameras with Built-in Microphone or External Microphone)

• SD Card Failure
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New high performance and specia l ty  EquIP Camera Suppor t

• HM4L8GR1: 8 MP IR Rugged Multi-Imager Dome

• HMBL8GR1: 8 MP IR Rugged Multi-Imager Bullet

• H4L6GR2: Low-Light 6 MP IR Rugged Dome

• HBL6GR2: Low-Light 6 MP IR Rugged Bullet

• HEPZ302W0: Ex-proof PTZ module

• HEPB302W01A04: 1080p 30x Explosion-Proof IP Camera, 4 m cable 

• HEPB302W01A10: 1080p 30x Explosion-Proof IP Camera, 10 m cable 

• HTMZ160T302W: Dual Sensor Thermal/Visual IP PTZ Camera

3D Positioning
3D Positioning feature enables you to view a specific object in a live video in 3-dimensional 
view. You need to draw a region on a live video to view a specific object in 3D mode. This 
feature is supported only with New EquIP PTZ (HDZ302DE, HDZ302D, HDZ302DIN) camera 
models.

New EquIP Series Camera Dewarping
New EquIP Fisheye Camera (HFD6GR1) is capable of delivering Fisheye view of the 
surrounding and which can also be dewarped to different view types depending on the 
mounting position.

H.265 Codec Support
H265 codec type is now supported to optimize the storage requirements for higher resolution 
cameras. H265 is only supported for New EquIP model cameras (HFD6GR1, HSW2G1, 
HCD8G, HBD8GR1, H4D8GR1, HDZ302DE, HDZ302D and HDZ302DIN). H.265 cameras 
supports GPU based Rendering. You can render upto 23 H.265 cameras with 1080P 
Resolution at 30 FPS/30 GOP.

Limitations of H.265 Codec Type:

• H.265 is not supported in MAXPRO Mobile app

• H.265 is not supported in Web client

Meta Data Conversion Utility
Meta data conversion utility allows you to replace or update the unique system ID number of 
the recorded clips and Meta data details for all or specific cameras. It helps you to retain your 
recorded clips and Meta data details during Failover /Failback operations. This allows a user 
to effectively playback the recorded clip without loss of video. Refer to the MAXPRO® NVR 
Installation and Configuration Guide.

Search
MAXPRO NVR supports multiple search features: Timeline Search, Preview Search, 
Alarm/Events Search, Calendar Search and SMART Motion Search.

360 Immersive Experience (Dewarping) Support
MAXPRO NVR supports client side dewarping integration with Oncam Grandeye and 
Immervision 360 applications. 
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Multi-language Support
MAXPRO NVR supports multiple languages such as English, French, Arabic, Russian, 
Spanish, Italian, Dutch, German, Czechoslovakian, Portuguese and Polish. English is the 
default language.

Keyboard Support
MAXPRO NVR supports industry standard Honeywell keyboards connected over Ethernet 
such as UltraKey Plus and UltraKey Lite.

Clip Export
MAXPRO NVR supports exporting clips with audio in - WMV, ASF and MPVC formats. It also 
supports exporting still images/snapshots in .BMP format. The clips can be signed with digital 
signatures to ensure authenticity.

MAXPRO NVR Clip Player
MAXPRO NVR Clip Player is a Honeywell proprietary clip player designed to only playback 
exported MAXPRO Container format (MPVC) clips. This clip player is part of the NVR 4.0 
package and can be accessed in the NVR installation folder.

Email Notification
MAXPRO NVR supports email notification on camera, system and operator events.

Video Surround Feature
MAXPRO NVR offers Video Surround, which provides the ability to track subjects of interest as 
they move between areas covered by adjacent cameras. Simply double-click on the panel 
where the subject is currently visible to track the subject.

Profile Cameras
Multi-zoom views on HD video and support for Profile cameras to create virtual cameras by 
digitally zooming into the field of view. Example: Zoom in on a cash register in one view of the 
HD camera and at the same time monitor the cash operator in the zoom out view of the HD 
camera.

Reports
Using the MAXPRO NVR, you can generate Event History and Operator Log reports, each of 
which has its own significance. These reports can be exported in PDF, Crystal Reports, Excel 
and Word formats.

Integration Capability
Multiple MAXPRO NVRs can be deployed for system expansion using a distributed 
architecture and integrated with the MAXPRO Viewer multi-site software or MAXPRO VMS 
enterprise video management system. MAXPRO also integrates with WIN-PAK® and Pro-
Watch® Access Control Systems.

Audio
MAXPRO NVR supports 1-way audio (camera to NVR) for specific IP cameras. Please refer to 
the MAXPRO NVR compatibility list at 
www.security.honeywell.com/hota/compatibility/index.html for the models supported.
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Web Client
The MAXPRO NVR Web Client allows you to remotely access the MAXPRO NVR server using a 
web browser like Internet Explorer and perform video surveillance. It gives you the flexibility to 
view live video and perform basic video surveillance functions remotely over the web. 
MAXPRO NVR Web Client supports viewing the live video, viewing Recorded Video 
(Playback), taking a Snapshot and viewing Presets.

Archival
This feature enables you to archive the recorded videos from the system manually or 
automatically to a NAS or SAN disk. You can define a specific schedule to archive the 
recordings periodically or you can manually archive whenever required. For both cases you 
should configure the disk in the Configurator > Disk tab.

Mobile Apps
MAXPRO NVR supports mobile monitoring clients on iOS and Android with MAXPRO NVR 
Mobile apps. The apps can be used to perform common daily tasks such as viewing live 
video, zooming in for full screen viewing, playback or searching for video by date and time, 
perform PTZ control through presets, monitor & manage alarms and taking a snapshot of a 
video frame. Recent enhancements also include One configuration for both Local and Remote 
server connection, Fingerprint Authentication login is support (only for IOS devices), Digital 
Zoom (only for IOS devices), HIS Streaming and HTTPS support 

Advanced Security
MAXPRO NVR supports advanced security features with encryption support for 
communication between desktop client to NVR and secure https login for the Web Client and 
Mobile App.
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MAXPRO NVR System Architecture

MAXPRO NVR Standalone System Diagram
The following figure illustrates the MAXPRO NVR SE system architecture.

Figure 1-1    MAXPRO NVR SE System Diagram

Note: The NVR SE box in the above system diagram is used as an example of a typical
system. Other System diagrams for NVRs (XE, PE and Software only) look similar
to the NVR SE and will only have minor differences.
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MAXPRO NVR Hybrid Standalone System 
Diagram 
The following figure illustrates the MAXPRO NVR HYBRID XE Standalone system architecture.

Figure 1-2    MAXPRO NVR HYBRID XE Standalone System Architecture

Note: The Hybrid NVR XE box in the above system diagram is used as an example of a
typical system. Other system diagrams for Hybrid NVRs (SE, PE) look similar to
the Hybrid NVR XE and will only have minor differences.
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MAXPRO NVR Distributed System Architecture
The following figure illustrates the MAXPRO NVR distributed system architecture.

Figure 1-3    MAXPRO NVR Distributed System Architecture
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2
Logging On and Getting Started

In this chapter...

Logging On Using Profiles

The MAXPRO NVR server addresses are saved in profiles. You need to select the profile 
before logging on. You can set a profile as the default profile. When a profile is set as the 
default, you do not need to select the profile each time you log on to MAXPRO NVR. You can 
also modify and delete profiles.

Logging On to MAXPRO NVR 

Caution: On Honeywell provided systems shipped with v4.0 or later version, a 
default Windows user: NVR-Admin and Password: Password$123 is 
already configured and will automatically log you in. Honeywell 
recommends you to create and use a new Administrator account to install 
and logon MAXPRO NVR. Refer MAXPRO NVR Installation and 
Configuration Guide, Securing MAXPRO NVR section for more 
information. 

1. Double-click  on the desktop. The Log On dialog box appears.

Or 
Click Start -> Programs -> Honeywell -> MAXPRO NVR. The Log On dialog box 
(Figure 2-1) appears.

Section See page...

Logging On Using Profiles 27

Getting to Know the MAXPRO NVR User Interface 32
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Figure 2-1    MAXPRO NVR Log on dialog box

2. Click the Language option, and then select the required language from the drop-down 
list. The supported languages are Arabic, Czechoslovakian, Dutch, Polish, Portuguese, 
French, German, Russian, Italian, Spanish, and English. The default language is English 
(US English). 

3. Clear the Windows Logged-In User check box and then enter your Username. The 
default user name is admin. Honeywell recommends to create a new NVR user in the 
Configurator tab and use the same to logon. Refer to the MAXPRO® NVR Installation and 
Configuration Guide. for more information on how to Add a user.

4. Type your Password. The default password is trinity.

Note: Select the Windows Logged-In User check box for logging on using the 
Windows authentication (uses current logged in Windows account credentials). If 
the Windows Logged-In User check box is cleared, the MAXPRO NVR user 
name and password is used for authentication. Ensure that you avoid using the 
@ character in your password. Honeywell recommends you to change the 
password before logging in. Refer MAXPRO NVR Installation and Configuration 
Guide, Changing the Default Password section to change the password. Also 
refer Password Complexity and Expiry Enhancements section.

5. If there is no profile set as default, then select the Profile corresponding to the MAXPRO 
NVR server to which you want to connect.

Note: Set profiles if you have multiple MAXPRO NVRs and use the drop-down to 
choose which NVR you would like to connect to.

6. Click Login. The Viewer tab appears.

Caution: Logon as Administrator only when an administrative activity need to be 
performed, Operator is preferred for all other activity.
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Tips for Logging On

• Click the Language option, and then select the required language from the drop-
down list. The supported languages are Arabic, Czechoslovakian, Dutch, Polish, 
Portuguese, French, German, Russian, Italian, Spanish, and English. The default 
language is English (US English). 

• Select the Windows Logged-In User check box for logging on using the Windows 
authentication (uses current logged in Windows account credentials). If the Windows 
Logged-In User check box is cleared, the MAXPRO NVR user name and password is 
used for authentication. 

• Ensure that you avoid using the @ character in your password.

• Set profiles if you have multiple MAXPRO NVRs and use the drop-down list to choose 
which NVR you would like to connect to.

• Select the Display Video on Alarm check box to display the viewer as an alarm 
monitor.

Note: Alarm monitor supports pop-up of camera associated to IO events only. Pop up 
on motion alarms is not currently supported.

Server Settings - Saving a Server Address in a 
Profile

1. In the client workstation, double-click the  icon on the desktop to display the Log On 
dialog box. (See Figure 2-1)

2. Click Server Settings. The Server Settings dialog box appears (Figure 2-2).

Figure 2-2    Server Settings dialog box

3. Click Add.

4. Type the Profile Name to identify the profile.

5. Type the Server IP/Name (numerical IP address or the network name of the MAXPRO 
NVR server).

6. Click Save.

7. Click OK. The server address is saved in the profile.

Tip: You can click Set Default in the server settings dialog box to set the profile as the default 
profile.
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Setting the Default Profile

1. Select the profile you want to set as default before logging on to the MAXPRO NVR.

2. In the User menu, , select Profiles -> Set Default Profile. The current profile is 

now set as the default profile. The default profile will be selected in the Profile box of the 
Log On dialog box the next time you logon.

Figure 2-3    Setting the Default Profile

Modifying a Profile
You can modify the profile name and the server address saved in the profile: 

1. In the client workstation, double-click the  icon on the desktop to display the Log On 
dialog box. 

2. Click Server Settings. The Server Settings dialog box appears (Figure 2-2).

3. In the Choose Profile box, select the profile you want to modify. The profile details 
appear under Configuration in the Server Settings dialog box.

4. Change the Profile Name, as applicable.

5. Change the Server IP/Name, as applicable.

6. Click Save.

7. Click OK. The profile is modified.

Deleting a Profile

1. In the client workstation, double-click the  icon on the desktop to display the Log On 
dialog box. 

2. Click Server Settings. The Server Settings dialog box appears (Figure 2-2).

3. In the Choose Profile box, select the profile you want to delete.

4. Click Remove.
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5. Click OK. The profile is deleted.

Editing the Ports
The MAXPRO NVR user interface includes a provision to modify the port number associated 
to the following components:

• Trinity Server

• Trinity Controller

• NeoEngine Server

To edit the ports:

1. In the Server Settings dialog box, click Edit Ports. The port numbers associated to 
Server IP/Name, Controller IP/Name and Storage Engine IP/Name are enabled for 
editing.

Figure 2-4    Editing the Ports

2. Change the port numbers, as applicable.

3. Click Save.

Logging Off
You can log off from MAXPRO NVR from the User menu. The name of the currently logged in 
user is displayed as the User menu on the top right of each screen.

1. Click the User menu, . The user menu options appear.

2. Click Log Off. The Logon dialog box appears after logging off from MAXPRO NVR.

Closing the MAXPRO® NVR User Interface
You can close the MAXPRO NVR user interface from the User menu. The name of the 
currently logged in user is displayed as the User menu on the top right of each screen.

1. Click the User menu, . The user menu options appear. 

2. Click Exit. A dialog box appears prompting you to confirm the action.

3. Click Yes.
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Getting to Know the MAXPRO NVR User 
Interface

The user interface of MAXPRO NVR is easy-to-use with its intuitive icons and user-friendly 
features. You can configure the devices in the video surveillance network through the 
MAXPRO NVR user interface. The user interface consists of tabs, tree-structures, status bar, 
floating windows, and icons. On opening the user interface, you see the following four tabs: 
Viewer, Configurator, Search and Report. Based on the tab you select, windows, tree 
structures, and other settings relevant to the tab appear on the screen.

A status bar is displayed at the bottom of the user interface. The status bar displays the 
connection status with the MAXPRO NVR server and controller, the status of clip creation, the 
role of the user, the number of unacknowledged alarms, and the time. 

Note: The tabs that are displayed in the MAXPRO NVR User Interface is dependent on 
the user's roles and privileges.

Viewer Tab
Figure 2-5 illustrates the Viewer tab. See the following table for descriptions of the Viewer tab 
components.

Figure 2-5    Viewer tab
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The following components are displayed on the Viewer tab screen.

Component Description

Devices/Site window A floating window that displays the recorders and 
cameras in a tree structure. You can select one or more 
devices from the Devices window to view its video in the 
Salvo Layout. 

The context menu options in the Devices window include:

• Show Live - to view live video. 

• Preview - to preview the live video.

• Refresh - to refresh the camera status.

• Refresh from Device - to refresh the camera status 
from the device.

• Show/Hide Device ID - to display or hide the device 
ID. 

• Sort By Name - to sort the list of devices by name. By 
default, names are sorted in ascending order.

Alarms/Output 
window

Click to display a floating window that lists the alarms. You 
can acknowledge and clear the alarms from this window. 
See the Alarms section on page 64 for more information.

Snapshot/Clip/Archiv
al window

Click to display a floating window that lists the 
snapshot/clips and Archival clips in a tree structure. You 
can select the images/clips and archival clips to view. The 
timeline window also displays the archival status as:

You can right-click on the images folder or the images to 
display a context menu. The context menu options 
include: 

• Refresh - to refresh the images/clips in the respective 
folder. 

• Show Video - to show the video.

• Delete - to delete an image.

• Show In Folder - to view the folder in which the 
images are stored.

See the Snapshots and Clips section on page 58 for more 
information.

Sequences window Click to display a floating window that lists the sequences. 
You can play the sequence using the play sequence 
action. 

You can right-click on the devices to display a context 
menu. The context menu options include:

• Play Sequence - to play any sequence. 

• Show Device ID - to display the device ID. 

• Sort By Name - to sort the list of sequences by name. 
By default, names are sorted in ascending order. 

Refer to the MAXPRO® NVR Installation and Configuration 
Guide for more information on configuring a Sequence.
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Views window A floating window that lists the salvo views. The View 
window consists of My Salvo Views and Shared Salvo 
views. Salvo views corresponding to the logged on user 
are listed under My Salvo Views in the Views window. 
You can copy a salvo view from My Salvo Views to 
Shared Salvo Views using the drag and drop option or 
right-clicking and selecting Add to Shared Salvo Views. 
Similarly, you can copy a salvo view from Shared Salvo 
Views to My Salvo Views using the drag and drop option. 
Devices grouped under Shared Salvo Views are 
displayed on all client workstations for any logged in user.

To add a salvo view to Shared Salvo Views, right-click on 
a salvo view, and then click Add to Shared Salvo Views. 
You can copy a salvo view from Shared Salvo Views to 
My Salvo Views by dragging and dropping a salvo view. 

You can right-click on the salvo view to display a context 
menu. The context menu options include:

• Show - to view the salvo view. 

• Rename - to rename a salvo view. 

• Remove - to remove a salvo view. 

• Save - to save a salvo view. 

• Add to Shared Salvo Views - to add a salvo view to 
the Shared Salvo views. 

• Show/Hide Device ID - to display or hide the device 
ID. 

• Refresh - to refresh the salvo views in the list. 

• Sort By Name - to sort the list of salvo views by 
name. By default, names are sorted in ascending 
order. 

See the Salvo View section on page 41 for more 
information.

Salvo Layout An arrangement of panels in which video is displayed. 
See the Salvo View section on page 41 for more 
information.

Timeline window A window that enables you to view video from a specified 
date and time. It also consists of other features such as 
mark in and mark out and selective viewing using 
bookmarks. You can also create clips from video 
recordings. You can select between the scrub mode or full

timeline mode using the  button. The timeline window 
also displays the recording colors as:

See the Viewing Recorded Video section on page 47 for 
more information.

Component Description
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Configurator Tab
Figure 2-6 illustrates the Configurator tab.

Figure 2-6    Configurator tab

From the Configurator tab you can add and configure video devices and set up the MAXPRO 
NVR system. Refer to the MAXPRO® NVR Installation and Configuration Guide for more 
information on configuring MAXPRO NVRs.

Components Description

System tab Helps you to configure the system level settings, 
Site information, Archival Schedule, 
Holidays/Exceptions settings, Event Server 
Configuration and Edge Syn Settings for MAXPRO 
NVR. 

Disk tab Helps you to configure the disk settings for video 
storage.

Camera tab Helps you to configure the camera settings. 

Schedules tab Helps you to configure the schedules for recording 
video.

IO tab Helps you to configure the input and output for a 
camera.

Sequence tab Helps you to select a sequence of cameras for live 
video.

User tab Helps in user administration. 
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Search Tab
Figure 2-7 illustrates the Search tab. 

Figure 2-7    Search tab 

You can search for recorded video and events from the Search tab. See Chapter 4 , Searching 
Recorded Video in MAXPRO NVR for more information.
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Report Tab
Figure 2-8 illustrates the Report tab. 

Figure 2-8    Report tab

See Chapter 5 , Generating Reports for more information.
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Monitoring a Site
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Live Video

You can view live video and play any selected sequence using the options available in the 
MAXPRO NVR Viewer tab.

Viewing Live Video
The panels in the salvo layout display video. You can select the video source to view, such as 
cameras or sequences, from the Devices/Site window. 

1. Click the Viewer tab.

2. Double-click the video source in the Devices/Site window. You can also drag and drop 
the video source on a panel in the salvo layout. You can select multiple video sources and 
view live video in different panels of the salvo layout.

Figure 3-1    A panel displaying live video

When you hover the mouse over a video display, toolbars appear over the panel. The toolbars 
enable you to perform actions such as flipping the video display, applying color correction, 
and so on. See the Video Control Options in the Panel Toolbars section on page 55.

The following table depicts the various status of the camera in Viewer tab:

Icons Status Description

Live Camera is recording Live

Continuous 
Recording

Camera continuously recording.

Disabled Camera is not recording and not live
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Note: For cameras configured with multi-streams, the stream selected as Preferred for
Live in the camera configuration and used for live video display. Right click to
view the context menu and then choose Switch Stream option to switch between
streams specified as High resolution or Low resolution streams in camera
configuration or select the stream name to switch to a specific stream.

Salvo View

A salvo layout that is customized based on your preference is called a salvo view. You can 
select the cameras and scan sequences that you want to frequently view and save the layout 
as a salvo view. The salvo view is saved and appears as an option in the Views window. When 
you want to view the video from the preferred cameras and scan sequences, you can select 
the saved salvo view.

Creating a Salvo View
1. Click the Viewer tab.

Note

• Before you create a salvo view, select the salvo layout you want with your 
preferred cameras and scan sequences. Drag and drop cameras and 
sequences and adjust the salvo layout until it is ready to save as a Salvo 
View.

• Salvo views can also be created with specific stream type for the cameras 
supporting multi-streams. Choose the stream type for each of the cameras in 
the salvo view before creating and saving a salvo view. For example: You can 
create and save a salvo view with all the low resolution streams, which can be 
used from remote clients with low bandwidth access to NVR.

2. Right-click on the toolbar, and then click Create Salvo view or click  on the toolbar on 
the top of the salvo layout. The Enter salvo view name text box appears.

3. Type the salvo view name and then click OK. The newly created salvo view is listed under 
Views -> My Salvo Views.

Salvo Bar 

A salvo bar appears on top of a salvo view. The salvo bar indicates the name of the salvo view. 
You can save a salvo view after you realign the cameras using the Save option on the Salvo 
Bar. You can also use the Save As option to save an existing salvo view with a different name. 
The context menu options on the salvo bar include Create Salvo View, and FullScreen.

Supported Salvo Views

The supported salvo views are 1-View, 4-View, 6-View, 9-View, 10-View, 13-View and 16-View. 
You can find all these view on the tool bar.
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Aspect Ratio

Aspect Ratio feature enables a salvo layout to display a view by maintaining same aspect 
ratio. This option is available on the tool bar and it supports three namely Default S - display 
stretch view, Aspect Ratio 16:9 - display 16:9 view and AspectRatio 4:3 - display 4:3 view. Click 

 to shuffle between aspect ratio display options.

Context Menu Options

When you right-click on a panel that is displaying live video, a context menu appears. The 
following table lists the commands in the context menu.

Command Click to... 

Full Screen Maximize the salvo layout to full screen.

Alternatively, you can click  in the toolbar 
on the top of the salvo layout.

Remove Text Overlay Remove text overlay displayed on the video. 
Alternatively, you can click  in the toolbar 
on the top of the salvo layout.

Digital PTZ Enable digital PTZ. See the Panning, Tilting, 
and Zooming section on page 56 for 
information on digital PTZ.

Add Bookmark Add a bookmark in the timeline. See the 
Adding a Bookmark section on page 54.

Mark In Add a mark in point in the timeline. See the 
Creating a Loop by Adding a Mark In and 
Mark Out Point in the Timeline section on 
page 52.

Mark Out Add a mark out point in the timeline. See the 
Creating a Loop by Adding a Mark In and 
Mark Out Point in the Timeline section on 
page 52.

Start Recording To start/stop the recording on a camera.

Save Image Save the frame displayed in the panel as an 
image in BMP format. Alternatively, you can 
click  in the toolbar on the top of the salvo 
layout to save the image in BMP format. 

Save Image As Save the frame displayed in the panel in 
different image formats such as JPG, PNG, 
and GIF. See the Saving Images section on 
page 58 for more information.

Preview View the preview of the video at any given 
time. You can view a list of previewed videos 
with the corresponding date and time stamp. 
Select a previewed video, and click  to 
export the previewed clip.

Show Surrounding Cameras To view video from the associated cameras. 
See the Live Video section on page 40 for 
more information.
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How to Enable/Use 3D Mode View
This feature is supported only for New EquIP PTZ (HDZ302DE, HDZ302D, HDZ302DIN) 
camera models.

To enable 3D mode view:

1. Right-click on the live video, the context menu options are displayed as shown below.

Calendar To open the Calendar search view, which 
enables searching for the recorded video.

See the Calendar Search section on page 97.

SMART Motion Search Display the SMART motion search dialog and 
to define and run the motion search on a 
recorded video. See the SMART Motion 
Search section on page 107.

3D Mode This feature is applicable only to New EquIP 
PTZ model cameras. Select this option to 
enable the 3D view. You can also center the 
field of view by clicking on any object in the 
live video.

See How to Enable/Use 3D Mode View 
section on page 43section for more 
information.

Reset 3D This option is displayed when you enable 3D 
Mode. Click this option to reset the 3D view. 
See How to Reset 3D Mode view section on 
page 46 section for more information.

Note: Rest 3D option resets the 3D view 
only at the first level.

Trigger Output Set the camera control output ON/OFF.

Save Profile Camera As Save a camera for a required profile view. 
See Profile Cameras section on page 58.

Goto Camera Settings Navigates to the specific camera settings 
window.

Panorama Settings Change the Panorama settings depending 
on your camera.

Switch Stream Switch between multi-streams from a 
camera. This option is only available for 
cameras configured with multiple streams. 

Command Click to... 
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Figure 3-2    3D Mode option

2. Click the 3D Mode option. 3D positioning for that camera is enabled.

3. Use the mouse to draw a rectangular region on any object in live video as shown below.

Figure 3-3    3D Rectangle Region

4. Release the mouse control immediately after drawing a rectangle. Only the object in the 
rectangular region is zoomed and positioned to center as shown below. You can also 
draw more regions on top of existing one to have a better view.
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Figure 3-4    Region Positioned 

Positioning the Field of View

After enabling the 3D Mode option in live video, you can also center any object in the scene 
with a mouse click.

For example. In a live video, if you want to center an object which is located on top right 
corner then you can simply click on that object. The object will be positioned to center as 
shown below. Similarly you can center any corner objects.

To center the any object in the scene

1. Click on any object in the scene. For example in this below image a Camera is highlights

Figure 3-5    Camera Object Highlighted
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2. Click on any object in the scene then the object is positioned to the center of the salvo 
pane as shown below.

Figure 3-6    Camera Object is Centered

How to Reset 3D Mode view

Reset 3D Mode option is displayed only when you enable 3D mode.

To reset the 3D mode view:

1. Right-click on the same live video onto which the 3D mode is enabled.A context menu 
options are displayed as shown below.

Figure 3-7    Context Menu Options
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2. Click Reset 3D option.

Note: Reset 3D option resets only 1 level of previous view. For example if you had
drawn a rectangular region twice to view the object closely, then this option
resets only the view of second rectangle region.

Playing a Sequence
A sequence is a set of live video streamed one after the other from cameras for a specified 
time interval. 

1. Click the Viewer tab. 

2. Click the Sequences window. 

3. Double-click the sequence you want to play or select the sequence, and then click Play 
Sequence. You can also drag and drop the sequence on a panel in the salvo layout. 

Viewing Recorded Video
You can use either the timeline or player controls to play recorded video.

Figure 3-8    Timeline Window

Timeline

Playing Recorded Video using the Timeline

Timeline enables you to play recorded video from a particular date and time. You can easily 
retrieve and view recorded video using the timeline and the date and time controls in the 
Timeline window. A timescale is displayed in the lower part of the Timeline window. You can 
refer to the divisions in the timescale to locate a video recording in the timeline. Using the date 
and time calendar box in the timeline window, you can select a date and time from which you 
want to play recorded video. When you select a panel from the salvo view to view video, a 
timeline appears in the Timeline window (See Figure 3-8). The name of the corresponding 
camera appears on the left of each timeline. 

You can also add comments and mark points of interest in the timeline using the bookmark 
feature. The bookmarks are helpful for future review of recorded video. (See the Marking 
Points of Interest in the Timeline using Bookmarks section on page 53). This enables you to 
locate moments of interest when reviewing recorded video. You can also add mark in and 
mark out points in a timeline (See the Playing Recorded Video Using Mark In and Mark Out 
Points in the Timeline section on page 52) to play a selected part of video repeatedly. Clips of 
the video recorded in MAXPRO NVR can be created from marked points in the timeline. This 
feature is referred to as loop playback of video. 

You can view the frames from the recorded video as thumbnails in the timeline. You can also 
create clips from recorded video.

To play recorded video using the timeline 

1. Click the Viewer tab.



M O N I T O R I N G  A  S I T E
Context Menu Options

48  MAXPRO NVR 5.0 Operator’s Guide

3

2. Select the camera. To select the camera, double-click the video source in the Site 
window. You can also drag and drop the camera on a panel in the salvo layout to display 
the video. Alternatively, you can select a panel displaying video to select that camera from 
which you want to view video. A timeline appears in the Timeline window with the name of 
the camera on the left in full timeline mode.

3. Play the recorded video from a date and time in one of the following ways:

• Click on the timeline from where you want to view video. You can refer to the 
divisions on the timescale that is displayed in the lower part of the timeline window to 
locate the date and time.
You can set any timescale between seconds and days using the  
slider. Move the slider left or right as required. This helps you to locate the video 
recording in the timeline. Click  to view the divisions on the left of the timescale. 
Click  to view the divisions on the right of the timescale.

Or

• Select the date and time in the date and time calendar box

 and then click OK. The video recording is played 
from the selected date and time.

Timeline Color Indicators

In the timeline, the time duration for which recording is available is indicated in green color. 
The time duration for which recording is not available is indicated in white color. This helps you 
to locate the video recording in the timeline. 

The timeline shows the green color and gray color only for the cameras connected to 
MAXPRO NVR. You can click the timeline to play the recorded video. The following table lists 
the colors that appear in the timeline.

The color indication for the type of recording on the timeline can be identified using Legends. 
Legends in the timeline window represents the type of recording (Continuous, Event or User 
and the type of Archival (Continuous or Event) status with specific color. Based on your 
settings you can identify which type of recording or archival.

For Recording

For Archival

Color Indicates...

Continuous recording.

Event based recording.

User based recording.

Recording is not available for the corresponding date and 
time.

Color Indicates...

Archival of Continuous recording
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Note: Archival timeline colors are only visible if the Continuous/Event/User based
recording does not exist for that timeframe.

Viewing Snapshots

Expand the camera name to the left of the timeline and the snapshots frames will appear.

Player Controls

You can play recorded video at speeds ranging from 1/64X to 256X. You can also forward and 
reverse play the video. The frames from the recorded video can also be viewed one at a time 
in the panel.

Using the time jump feature, you can skip time intervals while viewing recorded video. This 
feature is helpful when viewing recorded video that spans across a long time interval. 

See the Playing Recorded Video using the Timeline section for more information on timeline 
and player controls.

Archival of Event based recording

Color Indicates...
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You can perform the following actions using the player controls:

Player Control 
Name

Buttons Description

Play the video Click to Play video. The Play button changes to 
the Pause button when video is playing.

Click to forward play video.

Pause Click to Pause the playing of video. The Pause 
button changes to the Play button when video is 
paused.

View frames in the 
recorded video

FrameForward

Frame Reverse

Click Frames Forward to view the next set of 
frames.

Click Frames Reverse to view the previous set 
of frames.

Note: You can only view the frames when video 
is paused.

Live Click to play the Live video anytime.

Adjust the volume 
for audio enabled 
cameras

Click to mute/unmute the audio.

Hover the mouse over audio controls while video 
is playing and move the slider to adjust the 
volume.

Reverse Play Click to reverse play the video.

Change the playing 
speed

Hover the mouse over the playing speed 
controls while video is playing and move the 
slider to change the playing speed.

Note: The mouse scroll wheel can be used to 
move the slider. Scrolling up increases the speed 
and scrolling down decreases the speed. 

The speed appears in the icon when you move 
the slider. For example, 1x in the icon indicates 
the playing speed.

Skip time intervals 
using the time jump 
control

Skipping enables you to easily locate the portion 
of video you want to view in a recording. This is 
particularly useful when the video recording 
spans across a long time interval.

Click the jump drop-down arrow while video is 

playing and select a time interval to skip. Click 
 to jump the selected time interval backward 

or click  to jump forward by that interval.
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Context Menu Options 

A context menu appears when you right-click on a panel displaying recorded video. See the 
Context Menu Options section on page 42 for more information.

• Playing Recorded Video for Multi-Stream Cameras: By default Auto stream switch 
option is used during playback of recorded streams with preference for event based 
recordings. Auto stream switch ensures the streams configured as preferred stream 
for continuous recording and during playback preferred stream for event recording 
switch automatically. 

• Switch Stream option from the context menu can also be used to playback from 
individual streams. 

Surrounding Cameras 

You can associate a camera to a group of cameras using the Surrounding Cameras feature. 
This feature enables you to view video from a group of related cameras at the same time (for 
example, when you want to view video from cameras located in the same area). 

1. Click the Viewer tab.

Enable Sync 
Playback video 

Enable Sync Playback video option allows you 
to synchronize the display of video from multiple 
cameras. Select the cameras in the salvo layout 
and then select the Sync check box on the 
timeline window

or click the Enable Sync Playback video button 
on the tool bar above the salvo layout to enable 
sync playback mode. Any actions performed 
such as jump and forward will now be synched 
in the entire salvo layout. When a new camera is 
dragged and dropped, the video from that 
camera will also be synched.

Note: 

1. The Enable Sync Playback video feature 
only consumes one playback session 
out of 32 playback sessions available in 
MAXPRO NVR.

2. Using this feature, you can playback 
the selected camera’s sync time with a 
camera in playback mode using a 
single playback session.

3. Reverse playback mode is not 
supported. Use Jump to move in 
reverse.

4. The maximum number of playback 
streams supported in sync mode is 9.

Refresh Video  Refreshes/Reloads the video in the salvo layout if 
it is stuck.

Player Control 
Name

Buttons Description
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2. Click on the toolbar on the top of the salvo layout. The surrounding cameras salvo 
layout appears.

3. Select the camera for which you want to associate a group of cameras from the Devices 
window. You need to drag and drop the camera in the central panel of the salvo layout. 
The panel starts displaying video from the selected camera.

4. From the Site window, select the cameras you want to associate with the camera selected 
in step 3. The panel starts displaying video from the cameras.

5. Click  to save the surrounding cameras salvo layout after you have finished adjusting 
the salvo layout as required.

Switching to the Surrounding Camera View for a 
Camera

• Click  on the toolbar. The surrounding cameras salvo layout appears. Select the 
camera from the Site window. The surrounding cameras salvo layout starts displaying 
video from the camera and the associated cameras.

Or
• Hover the mouse at the bottom of the panel displaying video from the camera. A panel 

toolbar appears. Click  in the panel toolbar. The surrounding cameras salvo layout 

starts displaying video from the camera and the associated cameras.

Playing Recorded Video Using Mark In and 
Mark Out Points in the Timeline

The Mark in and Mark out feature is useful when you want to repeatedly play a portion of 
video. You can add a mark in point to mark the start date and time in the timeline and mark out 
point to mark the end date and time in the timeline. The portion of the timeline between a mark 
in and mark out point is referred to as a loop. User can also create a clip from this loop (see 
the Creating Clips section on page 59 for more information).

You can add bookmarks between a loop to identify moments of interest in the video. See the 
Marking Points of Interest in the Timeline using Bookmarks section on page 53 for more 
information.

Creating a Loop by Adding a Mark In and Mark Out Point in the 
Timeline

1. Click to select the timeline in the Timeline window in which you want to add mark in and 
mark out points.

Or
Click a panel displaying video to select the corresponding timeline.

2. To set the start date and time of the loop, add a mark in.

To add a mark in

• Click the point in the timeline where you want to add a mark in and click .
Or
Right-click the point in the timeline where you want to add a mark in and click 
Add Mark In in the context menu. 
Or
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The mark in can also be added from a panel displaying video. 
Right-click the panel and click Add Mark In in the context menu. The mark in is 
added at the corresponding date and time in the timeline.

3. To set the end date and time of the loop, add a mark out.

To add a mark out

• Click the point in the timeline where you want to add a mark out and click .
Or
Right-click the point in the timeline where you want to add a mark out and click 
Add Mark Out in the context menu. 
Or
The mark out can also be added from a panel displaying video. 
Right-click the panel and click Add Mark Out in the context menu. The mark out 
is added at the corresponding date and time in the timeline.

Note: You can add multiple mark in and mark out points in the same timeline. However,
you cannot add two mark in points in succession. A mark out point needs to be
added after each mark in point.

Tip: You can now create a clip of this loop. See the Creating Clips section on page 59 for more 
information.

Playing Video from the Loop

1. To select the loop, click anywhere between the mark in and mark out points. 

Note: A tool tip appears when you hover the mouse over a loop. The tool tip indicates
the start time and end time of the loop.

2. Click  to play the loop. You can also right-click on a loop to display a context menu 
and click Play Loop. 

Stopping a Video Loop 

1. In the Timeline window, click to select the loop.

Or
Click the panel displaying video pertaining to the loop. The corresponding timeline is 
selected.

2. Click . Alternatively, you can right-click the loop to display a context menu and click 
Stop Loop.

Marking Points of Interest in the Timeline using 
Bookmarks
You can add bookmarks in a timeline to mark points of interest in a video recording. For 
example, if you notice an event in the video and you want to review the portion later, you can 
add a bookmark. You can also add comments to the bookmarks and browse from one 
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bookmark to the other in the timeline. In addition, you can cut and copy a bookmark and 
paste it at a different point in the timeline. The bookmark comments appear as tool tips in the 
timeline at marked points and are helpful while reviewing recorded video. 

Adding a Bookmark

You can add a bookmark in one of the following ways:

• Click the point in the timeline where you want to add a bookmark and click .

• Right-click the point in the timeline where you want to add a bookmark and select Add 
Bookmark in the context menu.

• Right-click on the panel displaying video and select Add Bookmark in the context menu. 
The bookmark is added at the corresponding point in the timeline.

Adding Comments to a Bookmark

1. Right-click the bookmark in the timeline and select Add Comments in the context menu. 
A dialog box appears.

2. Type your comments in the dialog box and click OK. The comments are saved and 
appear as a ToolTip when you hover the mouse over the bookmark.

Note: To edit the comments, right-click the bookmark and select Edit Comments in the
context menu. Modify the comments in the dialog box and click OK.

Browsing from One Bookmark to the Other

Using this feature, you can skip the portions in the timeline that are not bookmarked. This 
enables you to selectively view video only from bookmarked portions in the timeline.

1. Select a timeline by clicking it in the Timeline window. You can also click on a panel 
displaying video to select the corresponding timeline.

2. Click  to view video from the next bookmarked point or click  to view video from the 
previous bookmarked point. 
Or 
Right-click a bookmark in the timeline to display a context menu. Click Next Bookmark to 
view video from the next bookmarked point or click Previous Bookmark to view video 
from the previous bookmarked point in the timeline.

Cut, Copy, and Paste Bookmarks

1. Right-click a bookmark in the timeline to display the context menu. Click the Cut or Copy 
command in the context menu, as needed.

2. Right-click the point in the timeline where you want to paste the bookmark and select 
Paste in the context menu.

Deleting a Bookmark

You can delete a bookmark in any of the following ways:

• Right-click the bookmark you want to delete and then select Remove Bookmark in the 
context menu that appears.
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• Select the bookmark you want to delete in the timeline and then click the  button or 
press the DELETE key.

Video Controls

Video Control Options in the Panel Toolbars
The panel toolbars appear when you hover the mouse over the video displayed in a panel. 
The toolbar that appears on top of a panel enables you to view the name of the video source 
and to close the video display. The toolbar that appears on the bottom of a panel consists of 
icons that enable you to perform the following actions:

Icon Click to...

Reset the digital PTZ effects on the video display.

Display the color correction window. Move the sliders to adjust the 
brightness, contrast, hue, and saturation settings. You can select the 
Blur check box to blur the video display and the Sharpness check 
box to increase the image sharpness or clarity.

Alternatively, you can click this button in the toolbar.

Note: Select the Apply color changes check box to save the 
settings. Clicking the Reset button sets the color correction settings 
to the default values. 

Displays a drop-down list of presets. You can select a preset for the 
camera. 

Note: The drop-down list is disabled when digital PTZ is enabled. 
You need to disable the digital PTZ feature to select a preset. See the 
Panning, Tilting, and Zooming section on page 56 for information on 
enabling and disabling the digital PTZ feature.

Move to a preset camera position. 

To move to a preset position, select a preset number from the drop-
down list and then click the button. The camera position (pan, tilt, 
and zoom) is moved to the selected preset. 

Note: The preset button is disabled when digital PTZ is enabled. You 
need to disable the digital PTZ feature to move to a preset. See the 
Panning, Tilting, and Zooming section on page 56 for information on 
enabling and disabling the digital PTZ feature.

Store a preset camera position.

To store a preset position, select a preset number from the drop-
down list and then click the button. The camera position (pan, tilt, 
and zoom) is saved to the selected preset.

Note: The button is disabled when digital PTZ is enabled. You need 
to disable the digital PTZ feature to store a preset position. See the 
Panning, Tilting, and Zooming section on page 56 for information on 
enabling and disabling the digital PTZ feature.

Starts Recording on a camera

View video from associated (surrounding) cameras. See the Live 
Video section on page 40 section.
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Tool Bar options to view video

Panning, Tilting, and Zooming
You can pan, tilt, and zoom (PTZ) the video displayed in a panel. Using the digital PTZ feature 
in MAXPRO NVR, you can perform panning and tilting on live and recorded video and clips. 
When enabled, the digital PTZ feature allows you to perform panning and tilting on the video 
display that is zoomed or enlarged.

Zooming the Video Display 

Use the mouse scroll wheel to enlarge (zoom in) or reduce (zoom out) the video displayed in 
the panel. Alternatively, hover the mouse over the video display. Click to zoom in or to zoom 
out the video display in the toolbar that appears.

Panning and Tilting

1. Right-click on the video displayed in a panel. A context menu appears.

2. Select Digital PTZ. The digital PTZ feature is enabled for that panel's video.

3. Zoom in on the video display.

4. Center-click anywhere on the video panel. A point along with left, right, up, and down 
arrows appear. 

5. Move the mouse in the required direction to pan and tilt.

6. Center-click again to stop panning and tilting. 

Set the Output control ON

Set the output control OFF

Save the camera view as a profile and this profile camera will be 
displayed under the Devices tree. See the Profile Cameras section 
on page 58.

Icon Click to...

Flip the video display. Alternatively, you can click this button in the 
toolbar on the top of the salvo layout.

View the mirror image of the video display. Alternatively, you can 
click this button in the toolbar on top of the salvo layout.

Icon Click to...
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PTZ Panel Bar

The PTZ panel bar provides you with the additional options to view the live video. It can be 
accessible by hovering the mouse on live video as shown in Figure 3-9 below.

Figure 3-9    PTZ Panel Bar

The toolbar that appears on the right of a panel consists of icons that enable you to perform 
the following actions:

Icon Click to...

Pan left 

Pan right

Tilt up

Tilt down

Zoom in to the video.

Zoom out of the video.

Iris open (Applies to PTZ cameras only)

Auto iris (Applies to PTZ cameras only)

Iris close (Applies to PTZ cameras only)

Focus near (Applies to PTZ cameras only)
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Profile Cameras
With Profile Cameras, multi-zoom views on high resolution video can be used to create virtual 
cameras by digitally zooming into the field of view. Example: Zoom in on a cash register in one 
view of the HD camera and at the same time monitor the cash operator in the zoom out view of 
the HD camera. Right click on a camera view and click on Save Profile Camera As to save 
the virtual view as a camera in the device tree.

Profile cameras defined are local to given system. Profile cameras created in MAXPRO NVR 
cannot be discovered in MAXPRO VMS. Profile cameras do not consume any camera channel 
license and are not considered for camera license count.

Note

• Profile Cameras created are listed in the Device Tree but displaying camera 
status is not supported for Profile Cameras.

• Maximum number of Profile Cameras that can be created per NVR system is 
unlimited.

Snapshots and Clips

Saving Images
While viewing video in the panel, you can save a frame of the video as an image. The image 
can be saved in Bitmapped Graphics (BMP) format, Joint Photographic Experts Group format 
(JPG), Portable Graphics format (PNG), and Graphics Interchange Format (GIF).

1. Click the Viewer tab.

2. Right-click the panel with the required image to display the context menu.

3. Select Save Image to save the image in BMP format. Alternatively, you can click  on 
the toolbar on top of the salvo layout. The images are saved in the SnapshotsAndClips 
folder at the location in the hard drive in which MAXPRO NVR files are installed. For 
example, X:\Program Files\Honeywell\TrinityFramework\ImagesAndClips.

Or
Select Save Image As to open the Save As dialog box and save the image in other for-
mats. You can select the format in the Save As Type drop-down list and enter the image-
File Name. You can also select a different folder for storing the image.

Auto focus (Applies to PTZ cameras only)

Focus far (Applies to PTZ cameras only)

Icon Click to...
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Saving the Salvo Layout as an Image

Click  on the toolbar to capture salvo snapshot.

The salvo layout snapshot is saved as an image (BMP format) in the SnapshotsAndClips 
folder. The images saved in the SnapshotsAndClips folder appear in the Snapshots/Clips 
window. See the Viewing Snapshots, Exported clips and Archival Recordings section on page 
62 for information on how to view saved images.

Creating Clips
You can create clips from recorded video. These clips can be saved with digital signatures. 
Digital signatures ensure the authenticity of clips. Digital signatures are primarily used to 
authenticate videos that are produced in courts as evidence. A digital signature generates a 
unique string for the clip using algorithms recommended by the W3C. The World Wide Web 
Consortium (W3C) is an international consortium where member organizations, a full-time 
staff, and the public work together to develop Web standards. If the video in the clip is 
modified, a verification check for the unique string fails and indicates that the content is 
tampered. When a clip is saved with the digital signature, a package file with the PKG 
extension is created to save the clip.

Note 1. MAXPRO NVR 3.1 SP1 or later version supports exporting video clips 
with audio on supported IP devices configured for audio recording along 
with video.

2. MAXPRO NVR 3.1 SP1 or later version exported clips (WMV/ASF), for 
Oncam Grandeye cameras supported by the NVR, can be dewarped 
using the Oncam Grandeye 360-degree Viewer application. For further 
details on Oncam Grandeye 360-degree Viewer, refer to the site: 
http://www.oncamgrandeye.com/63-oncam-grandeye-360-degree-
viewer.html

3.Anonymization feature is supported for Clip Export operation. However, 
If a user exports a clip with Anonymization then only WMV format is 
supported.

Creating a Clip

1. Click the Viewer tab.

2. Specify the loop for which you want to create a clip.

3. Click  in the Timeline window. The Create Clip dialog box appears with the Stream 
Name of the camera from which video is displayed in the salvo layout.

Or
Right-click a loop in the Timeline window and select Export Clip in the context menu. A 
dialog box appears.

4. Select one of the following options in the dialog box:

Option Select to...

Include only marked area and 
Auto split on recording gap

Save one or more loops in the timelines as 
clips. This option is selected by default.
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5. Under Streams, select the camera stream to save. The video and the audio from the 
selected camera stream are saved as clips.

Note: Exported clips includes the video streams from the selected cameras and any
recorded audio. Currently Clip export supports audio recordings.

6. Under Stream, select the required Format. You can export the clips in WMV or ASF or 
MPVC formats. See the WMV, ASF and MPVC Formats section on page 62 section for 
more information.

7. Enter a Job Name or retain the default name assigned by MAXPRO NVR. 

8. Select the Location (folder in which you want to save the clip). You can click  to 
select a different folder location instead of the default location.

Note: Do not select the OS drive to save clips longer than 1 hour. If a OS drive is
selected to save a clip the following message is displayed:
The Selected C : drive for clip export has less than 10 GB free space. Select
an alternate drive with sufficient space. Insufficient space in Windows OS
partition (Less than 10 GB) can cause system instability. Do not save clips
longer than 1 hour duration on OS partition.

9. To archive the clip with the digital signature, select the Archive and Digital Signature 
check box. A package is created with all the exported clips and stored in the specified 
location. Digital signature is only supported for WMV format clips.

10. Enter any Comments for the job to be created.

11. Select the Include MPVC Clip Player check box to play the recordings of MPVC format 
files. This option is only supported for MPVC clip format exports.

12. Select the Split Clip Size check box and then select the required size and units from the 
corresponding drop down boxes.

Note

• The Estimated the Clip Size box displays the total size of the clip that is 
being exported. Based on this you can split the clip to optimize the size of 
each clip to match the storage media being used for saving clips. You can 
split the clip size upto 1.5 GB.

• Split Clip Size and Estimated Clip Size features are not support for WMV 
format exports. 

• For ASF format clip export, recommended clip duration is less than 24 hour 
per clip. If user wants to perform clip export for multiple days then export the 
clips for each day individually.

Create clip for specified 
duration

Specify the time duration of video that you 
want to save in the clip. After selecting this 
option, the date and time (start and end) can 
be specified in the From and To boxes. 

Option Select to...
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• Anonymization feature is supported for Clip Export operation. However, If a 
user exports a clip with Anonymization then only WMV format is supported.

13. Click OK to create the clip. The clip creation status is indicated in the status bar. The clip 
is saved with an automatically generated name (unless a name was entered in step 7).

Note: The playback session is closed while creating a clip from the cameras connected
to the recorder with playback limitation. You have to restore the playback session
manually after the clip creation is complete. 

Canceling Clip Creation
1. Click the clip creation status indicator in the status bar. The Clip Export Status dialog box 

appears. 

2. Right-click the job name that you want to cancel, and then select Cancel. To cancel all 
the jobs, select Cancel All. 

Naming Convention for Exported Clips

The following table explains the automatic naming convention for a clip using the example 
below:

• Example of a clip name with WMV format: 080109125809_CameraDoor_(1).WMV.

• Example of a clip name with ASF format: 080109125809_CameraDoor_(1).ASF.

Clip Name Description 

080109 

(year, month, day)

The first two digits indicate the year, the next 
two digits indicate the month, and the last two 
digits indicate the day of clip creation.

125809 

(hours, minutes, seconds)

The first two digits indicate the hour, the next 
two digit indicate the minutes, and the last two 
digits indicate the seconds.

CameraDoor The name of the camera.

(1) The file extension for the clip.

WMV The file extension for the clip.

ASF The file extension for the clip.

Note For ASF format clip export, 
recommended clip duration is less than 
24 hour per clip. If user wants to perform 
clip export for multiple days then export 
the clips for each day individually.

MPVC The file extension for the clip.
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WMV, ASF and MPVC Formats

Clips can be exported in either WMV, ASF or MPVC formats. When compared to WMV format, 
the ASF, MPVC formats are much faster and more reliable. The following table describes the 
difference between WMV, MPVC and ASF formats.

Note 1. ASF format clips are supported in NVR version 3.1 SP1. This format is 
recommended for clip durations longer than an hour for exporting as 
backup clips.
2. WMV format clips are recommended for clip durations that are less 
than an hour for exporting as evidence clips.
3. Anonymization feature is supported for Clip Export operation. However, 
If a user exports a clip with Anonymization then only WMV format is 
supported.

Viewing Snapshots, Exported clips and 
Archival Recordings

From the Snapshot/Clips window, you can view the images and clips saved in the 
Snapshots/Clips folder (at the location in the hard drive in which MAXPRO NVR files are 
installed). 

1. Click the Viewer tab, and then click the Snapshot/Clips tab. 

2. In the Snapshot/Clips window, expand the Snapshots and Clips folder. Folders with 
names indicating the date in which the images and clips are created appears. The folder 
naming format is day/month/year.

WMV Format ASF Format MPVC Format

WMV is traditional and slow. ASF format is faster at exporting a 
clip. It takes 50 minutes to export a 
24 hour clip without much 
difference in the size of the clip.

Its Honeywell Proprietary format. 
Archival recordings are also stored in 
MPVC format. 

Text overlay is not supported in the 
NVR viewer with ASF formats.

WMV format converts the packets 
into MPEG formats and then 
displays the video.

ASF format takes the raw data 
from the packets and displays the 
video directly without conversion. 
This makes the ASF format faster 
in processing the video.

MPVC format takes the raw data from 
the packets and displays the video 
directly without conversion.

This makes the MPVC format faster 
and best quality in processing the 
recorded video.

ASF format does not display the 
Time Stamp on the clip. To view 
the Time stamp it is recommended 
to play the clip with the VLC Player. 
(http://www.videolan.org/vlc/index.
html)

You can playback the MPVC format 
using MAXPRO Clip player which is 
designed only for MPVC format clips.
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3. Expand the folder with the date of the image or clip you are looking for. Inside the folder, 
the video clips are saved in the Clips sub-folder and images are saved in the Images 
sub-folder.

4. You can refresh the list of images and clips in the Snapshots/Clips window. Refreshing 
the list displays the latest images and clip names (such as a recently saved clip). To 
refresh, right-click in the Snapshots/Clips window to display a context menu and click 
Refresh.

Viewing Images
Use the following method to view images:

• In the Snapshot/Clips window, right-click the image to display a context menu and 
then Show in Folder. The images saved in the Snapshots/Clips folder (at the 
location in the hard drive in which MAXPRO NVR files are installed) is displayed.

Viewing Video Related to an Image

If a video recording is available, you can view video from the same date and time as the saved 
image.

In the Snapshots/Clips window, right-click the image to display a context menu and select 
Show Video. The video is played from the starting date and time of the saved image.

Viewing Clips
Use any of the following methods to view a clip:

• In the Snapshots/Clips window, right-click the clip to display a context menu and select 
Show Video. The video is displayed in the salvo layout.

Or
• Double-click the clip. 

Or
• Drag the clip onto a panel in the salvo layout.

Viewing the Clips Folder
• In the Snapshots/Clips window, right-click the Clips folder or any clip to display a 

context menu and select Show In Folder to view the folder in which the clips are saved. 

Deleting Images and Clips
In the Snapshot/Clips window, you can delete the images and clips that you do not need: 

1. Click the Viewer tab.

2. Expand the folder(s) to find the image/clip you want to delete. 

3. Right-click the image or clip which you want to delete. A context menu appears.

4. Click Delete.

Viewing Archival Recordings
In the Snapshot/Clip window, right click on the Archival node, click on Add Archival Location 
sub-menu item to choose the Archival storage. The Archival storage location selected is 
scanned and the archival tree display is formed intelligently to display folder with camera id as 
root and the archival recording folders by date for that camera under it containing the archival 
MPVC format clips. Double click or drag/drop any of the clips to play in the MAXPRO NVR 
client salvo view. 
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Alarms

Alarms notify operators of the occurrence of events. You can configure alarms to be triggered 
for the following types of events: adding a camera, recorder disk space nearing full, motion 
detection, and so on. The events that trigger an alarm can be selected while configuring 
MAXPRO NVR.

Each alarm goes through the following states.Refer to the MAXPRO® NVR Installation and 
Configuration Guide, Appendix B for more information on various types of Alarm and Events.

• New or Unacknowledged

• Acknowledged

• Cleared

• Beep on alarm

New or Unacknowledged 

When an alarm is triggered it appears in the Alarm window. The state of the alarm after it is 
triggered is referred to as unacknowledged. You can view the list of all the unacknowledged 
alarms in a table in the Alarm window (see Figure 3-10). 

Figure 3-10    Alarms Window

For each unacknowledged alarm, the following details are listed:

Column Indicates... 

Description Name of the event that triggered the alarm. For example: camera 
motion detected.

Event Details Name of the event attribute. Only the key event attribute is displayed 
in this column.

Device Name of the device such as a recorder or camera associated with the 
event. For example: the name of the camera that detected motion.

IO Status Displays the input and output status.

Date:Time Date and time when the alarm is triggered. 

Master Device 
Name

the device responsible to generate the specific alarm.

Severity Severity of the alarm. Refer to the MAXPRO® NVR Installation and 
Configuration Guide for more information on configuring default 
Event and Alarm types and their severity levels for Camera, Recorder 
and Smart VMD.
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The number of unacknowledged alarms is displayed in a red blinking mode in the status bar 
(for example, Alarms (10) indicate that there are ten unacknowledged alarms).

Acknowledged 

An acknowledged alarm indicates that the operator has taken the necessary action. After 
acknowledging the alarm, it is moved to the acknowledged alarms list in the Alarm window.

Cleared 

After the response action is taken, you can remove or clear the alarms from the acknowledged 
list in the Alarm window.

Beep on alarm 

The beep on alarm option can be selected if you want the beep sound to occur when there is 
an active alarm. The option is selected by default. To deselect the option, right-click the alarms 
indicator on the status bar, and then click to clear the Beep on Alarm check box.

Acknowledging Alarms
You can acknowledge an alarm to accept that the necessary response action is being taken.

1. Click the Viewer tab, and then click the Alarm tab.

2. Select the alarm you want to acknowledge in the Alarm window. The unacknowledged 
alarms are listed in the first table in the Alarm window.

Tip: To select more than one unacknowledged alarm, hold the CTRL key down while you 
select alarms.

3. Click Acknowledge. The acknowledged alarm appears in the second table in the Alarm 
window. If you have selected multiple alarms, all the alarms are acknowledged and 
appear in the second table in the Alarm window. 

Unacknowledged Alarms Context Menu Options

When you right-click on the list of unacknowledged alarms in the first table, a context menu 
appears. The following table lists the commands in the context menu: 

Site Site name where the device is located.

Global ID Global unique identification number of the event. Each camera will 
have one event id and it is used while playing back the recording. 
Global ID is used in MAXPRO VMS to search a recording.

Column Indicates... 

Command Click to....

Ack Acknowledge the selected alarm. 

Clear on Ack Automatically clear the alarms when they are acknowledged.

Ack All Acknowledge all the alarms.

Show Video View video from the time corresponding to the occurrence of the 
event that triggered the alarm. The video is played in the currently 
selected panel in the salvo layout. 

Note: The video is played only when the video recording is 
available.

Show Preview 
Pane

View video related to the alarm in a four panel salvo layout. Refer to 
the MAXPRO® NVR Installation and Configuration Guide for more 
information on Setting Preferences. 



M O N I T O R I N G  A  S I T E
Alarms

66  MAXPRO NVR 5.0 Operator’s Guide

3

Clearing Acknowledged Alarms
You can clear the acknowledged alarms after taking the necessary action.

1. Click the Viewer tab.

2. Select the alarm you want to clear in the Alarm window. The acknowledged alarms are 
listed in the second table in the Alarm window.

Tip: To select more than one unacknowledged alarm, hold the CTRL key down while you 
select alarms.

3. Click Clear. The alarm is removed from the list of acknowledged alarms. If you have 
selected multiple alarms, all of the selected alarms will be cleared..

Clearing All of the Acknowledged Alarms 
Click Clear All. All of the acknowledged alarms are cleared and removed from the list of 
acknowledged alarms.

Acknowledged Alarms Context Menu Options 

When you right-click on the list of acknowledged alarms in the second table, a context menu 
appears. The following table lists the commands in the context menu:

Show Details View the details of the alarm. This feature lists the device from which 
the alarm was triggered, description, date time when the alarm was 
triggered, status of the alarm, global event ID, and the event attribute 
associated to the alarm. You can also use the previous and next 
buttons to view the details of the alarms listed in the alarms window. 

Freeze Stop receiving the new or unacknowledged alarms in the Alarm 
window. You can click this command again to start receiving the 
alarms. This feature is useful when the Alarm window contains many 
unacknowledged alarms and it becomes difficult to manage them. 
You can stop receiving the alarms momentarily and start receiving 
again when needed. 

Receive 
Alarms Only 

List only the alarms in the Alarm window. Alarms are listed only 
when the severity level of the corresponding event that triggered the 
alarm is greater than or equal to the alarm severity threshold value. 
Refer to the MAXPRO® NVR Installation and Configuration Guide for 
more information on Setting Preferences.

Receive 
Events Only

List only the events in the Alarm window. Events whose severity 
level is greater than or equal to the alarm severity threshold value are 
listed. Refer to the MAXPRO® NVR Installation and Configuration 
Guide for more information on Setting Preferences.

Receive Both 
Alarms and 
Events 

List both alarms and events in the Alarm window. 

Command Click to....

Command Click to....

Clear Clear the selected acknowledged alarm. 

Clear All Clear all of the acknowledged alarms.
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Show Video View video from the time corresponding to the 
occurrence of the event that triggered the alarm. The 
video is played in the currently selected panel in the 
salvo layout. 

Note: The video is played only when the video 
recording is available.

Show Preview Pane View video related to the alarm in a four panel salvo 
layout. Refer to the MAXPRO® NVR Installation and 
Configuration Guide for more information on Setting 
Preferences. 

Show Details View the details of the alarm. This details lists the 
device from which the alarm was triggered, 
description, date/time when the alarm was triggered, 
status of the alarm, global event ID, and the event 
attribute associated to the alarm. You can also use the 
previous and next buttons to view the details of the 
alarms listed in the alarms window. 

Freeze Stop receiving the new or unacknowledged alarms in 
the Alarm window. You can click this command again 
to start receiving the alarms. This feature is useful 
when the Alarm window contains many 
unacknowledged alarms and it becomes difficult to 
manage them. You can stop receiving the alarms 
momentarily and start receiving them again, as 
required. 

Clear on Ack Automatically clear the alarms when they are 
acknowledged. 

Receive Alarms Only List only the alarms in the Alarm window. Alarms are 
listed only when the severity level of the 
corresponding event that triggered the alarm is 
greater than or equal to the alarm severity threshold 
value. Refer to the MAXPRO® NVR Installation and 
Configuration Guide for more information on Setting 
Preferences.

Receive Events Only List only the events in the Alarm window. Events 
whose severity level is greater than or equal to the 
alarm severity threshold value are listed. Refer to the 
MAXPRO® NVR Installation and Configuration Guide 
for more information on Setting Preferences.

Receive Both Alarms and 
Events 

List both alarms and events in the Alarm window. 

Command Click to....
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Video Viewing Options from Immervision 
Enabled Cameras

You can drag and drop Immervision enabled cameras onto the viewer, and view live video 
from them. These cameras support several different modes for viewing live video (see the 
following sections for more information).

Perimeter Mode
Perimeter mode divides the video into two parts (see Figure 3-11 for an example).

Figure 3-11    Perimeter Mode

Quad Mode
In Quad mode, you can see four different fisheye views on a single salvo panel. In each of the 
views, you can Zoom in, Zoom out, Pan up, pan down, Tilt up, and Tilt down the video. See 
Figure 3-12 for an example of Quad mode.
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Figure 3-12    Quad Mode

PTZ Mode
In PTZ mode, you can see a single view, which enables you to use PTZ commands with the 
video (Zoom in/out, Pan up/down, Tilt left/right). See Figure 3-13 for an example of PTZ mode.

Figure 3-13    PTZ Mode
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Panomorph Settings in the Viewer
At any point of time, while viewing video in a particular mode with an Immervision camera, you 
can switch to a different mode using the Panomorph settings available in the Viewer.

Viewing video in Different Modes

Right-click the panel displaying live video, select Panomorph Settings in the context menu, 
and then select one of the modes (PTZ Mode/Quad Mode/Perimeter Mode), as applicable 
(see Figure 3-14).

Figure 3-14    Panomorph Settings in the Viewer
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Video Viewing Options from Oncam 
Grandeye Cameras

You can drag and drop Oncam Grandeye cameras onto the viewer, and view live video from 
them. Live video modes for some of the Halocam and Evolution cameras are shown in the 
following illustrations (Figure 3-15).

Figure 3-15    Virtual Camera View

Right-click the panel displaying live video (for a Evolution camera), select Panorama settings, 
and then select any mode to view live video in that mode.

The following figures display various views/modes:

• Virtual Camera View (Figure 3-16)

• Panorama 2x 180 views (Figure 3-17)

• Panorama 1x 360 views (Figure 3-18)

• Panorama 1x 180 views

• VCam Quad Position 1

• VCam Quad Position 2

• VCam Quad Position 3

• VCam Quad Position 4
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Figure 3-16    Panorama 2x180 View

Figure 3-17    Panorama 1x360 View
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Figure 3-18    Panorama 1x 180 views

Figure 3-19    VCam Quad Position 1
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Figure 3-20    VCam Quad Position 2

Figure 3-21    VCam Quad Position 3
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Figure 3-22    VCam Quad Position 4
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Video Viewing Options of Dewarped New 
EquIP Camera 

New EquIP Fisheye Camera (HFD6GR1) is capable of delivering Fisheye view of the 
surrounding and which can also be Dewarped to different view types depending on the 
mounting position. To Dewarp the video you need to configure the camera General > 360 
Settings pane. Refer to MAXPRO NVR Installation and Configuration Guide for more 
information on configuring the New EquIP model camera to support dewarping.

Right-click the panel displaying live video (for a New EquIP model camera) and then select 
Panorama settings. Select any mode to view live video in that mode.

The following table and figures display various views of New EquIP model camera based on 
the mounting position:

Figure 3-23    EQUIP-Fish Eye View

  Modes
 FishEye 

View
 (Figure 3-23)

 Quad View
 

 (Figure 3-24)

 1 Panorama & 
3 Quatro View
 (Figure 3-26)

 Panorama 
2x 180 Views
 (Figure 3-25)

 1 Fish Eye & 
3 Quatro View
 (Figure 3-27)

Mounting
Position

Wall Mounting Supported Supported Supported Not Supported

Ceiling Mounting Supported Supported Not Supported Supported Supported

Ground Mounting Supported Supported Not Supported Supported Supported
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Figure 3-24    EQUIP - Quad View

Figure 3-25    EQUIP - Panorama 2X180 View
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Figure 3-26    Equip - 1 Panorama & 3 Quatro View

Figure 3-27    EQUIP - 1 Fish Eye 3 Quatro View
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Video Viewing Options of Venus and Helios 
EquIP Series Cameras

New Venus EquIP series camera (HM4L8GR1: Multisensor Dome/Bullet) is capable of 
delivering stitched view. 

New Helios EquIP series camera (HTMZ160T302W: Dual Sensor Thermal/Visual IP PTZ 
Camera) is capable of delivering thermal view. 

Refer to MAXPRO NVR Installation and Configuration Guide for more information on 
configuring the High Performance EquIP model (Venus/Helios) cameras.

Below sample images displays Venus Stitched view and Helios Thermal view

Figure 3-28    Venus Stitched view

Figure 3-29    Helios Thermal View
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MAXPRO Status Monitor

MAXPRO Status Monitor application allows you to monitor the status of system and Recording 
Engine in a network.You can manually add or auto search the required NVRs and then 
connect to a single or multiple NVRs (System or Recording Engine) to monitor the status of 
various parameters. In addition, color indications are also available to identify the status of the 
system. The colors of the status and the description are given below.

• Green: Everything is Fine

• Blinking between yellow and green: Not Recording

• Blinking between Yellow and red: Database Connection lost

• Status message Database Connection lost. Indicates the status of database 
connection.

How to access the application

• MAXPRO Status Monitor is part of NVR 4.0 package. It is installed along with the NVR

4.0 software only solution. Double-click  on your desktop.
Or
Click Start > All Programs > Honeywell > Maxpro NVR Tools and then click 
MAXPRO Status Monitor. By default the status monitor starts searching the NVRs in 
you network.

Tool bar options

Monitoring the status of a System
To monitor the system status:

1. Launch the MAXPRO Status Monitor as explained in How to access the application  By 
default the status monitor starts searching and displays the available MAXPRO NVRs in 
your network. The application is displayed as shown in Figure 3-30. 

Icon/Option Description

Remove: Removes the NVRs from the list. 

Interval: You can set time intervals under this option. It allows you 
to set the Refresh Intervals during which you want to monitor the 
status. The intervals vary from 1 second to 30 second. You can set 
the required time interval for the system to refresh the status.

Views: This option enables you to switch between views. Available 
options are list view and table view. Select the required one to view 
the data accordingly.

Allows you to add new NVRs manually.



. 
. 
. 
. 
.

M O N I T O R I N G  A  S I T E

MAXPRO Status Monitor

MAXPRO NVR 5.0 Operator’s Guide 81

Note: By default the status monitor starts searching and displays the available
MAXPRO NVRs in your network. If you want to manually search, under Add NVR,
type the IP Address/Host name and then press Enter. See Monitoring the status
of a System Manually section on page 82 section for more information.

Figure 3-30    MAXPRO Status Monitor Home screen

2. Select the required Or multiple NVR check boxes and then click the Connect button. The 
status of system is displayed as shown in Figure 3-31.

Figure 3-31    System status of NVR
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Note: By default the System status is displayed.

Monitoring the status of a System Manually
To monitor the status of a system manually:

1. Launch the MAXPRO Status Monitor as explained in How to access the application . By 
default the status monitor starts searching the NVRs in you network. as shown in 
Figure 3-30. 

Figure 3-32    MAXPRO Status Monitor Home screen
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2. Under Add NVR, type the IP Address/Hostname that you want to monitor and then press 
Enter. The status of specific NVR is displayed in list view as shown in Figure 3-33.

Figure 3-33    Status of NVRs

3. Select the required NVR check boxes and then click Connect to view the status.

How to set the Refresh Interval
Refresh intervals can be set while you are monitoring the status in List or Table view.

To set the refresh intervals:

1. On the tool bar, click  icon. The Refresh Interval options are displayed based on 
your selected view.

Figure 3-34    Refresh Intervals

2. Click on the required time interval check box on the scale of 1 to 15 seconds. The status 
is displayed accordingly.
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Introduction to Profile-G or Edge Recording 
Sync

Profile-G or Edge Recording Sync feature allows you to sync the recordings from the camera 
SD card to MAXPRO NVR. Camera SD card contains recordings that are configured on 
demand. This features enables the user to playback only those recording which are saved in 
the SD card after they are synced to MAXPRO NVR. User can enable the Edge Sync option in 
Camera page and then configure the day/time for Edge Sync in the System window to get the 
recordings from the camera. Edge Sync feature is applicable only to the cameras with SD 
card. This feature is supported only for Mercury model cameras for now.

Below table details the camera models and firmware details for Profile G supported cameras. 

Note: Only the below Profile G compliant camera models with Firmware supports the
Edge Syn feature.
Profile-G compliant camera time should be in sync with NVR time.
Ensure you configure the NTP server to avoid Time Sync related issues.

Camera Models Details Firmware

H4W2GR1 Outdoor Dome 2MP 
2.7-12mm

V1.000.HW00.6, build: 2017-10-16

H4W2GR2 Outdoor Dome 2MP 7-
22mm

H4W4GR1 Outdoor Dome 4MP 
2.7-12mm

H3W2GR1 Indoor Dome 2MP 2.7-
12mm

H3W2GR2 Indoor Dome 2MP 7-
22mm

H3W4GR1 Indoor Dome 4MP 2.7-
12mm

HBW2GR1 Bullet 2MP 2.7-12mm

HBW2GR3 Bullet 2MP 4.7-47mm

HBW4GR1 Bullet 4MP 2.7-12mm

HCW2G Box 2MP

HCW4G Box 4MP

HCL2G Box 2MP low light

V2.420.HW01.19, build: 2017-10-16
H4L2GR1 Outdoor Dome 2MP 

2.7-12mm low light

HBL2GR1 Bullet 2MP 2.7-12mm 
low light
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How to Configure Profile-G or Edge Recording 
Sync Feature
To configure the Profile-G or Edge Sync feature, perform the following in the order 
mentioned.:

1. Upgrade the Camera Firmware.

• Enable SD card recording with required settings

2. Upgrade MAXPRO NVR to the latest version

3. Configure the Edge Sync Settings

• Enable the Edge Sync feature

Note: Profile-G compliant camera time should be in sync with NVR time.

Ensure you configure the NTP server to avoid Time Sync related issues.

Upgrade the Camera

Before  Upgrading

• If there are critical recordings available in SD card, please take back up using 
camera web page before upgrading the firmware.

• Upgrade to the Camera Firmware versions to latest versions as mentioned in the 
above table.

• It is recommended to use IPC utility to upgrade the Camera Firmware.

Note: Ensure that there is no Camera power fluctuations during the upgrade
procedure. This is to ensure smooth camera firmware upgrade.

Post Upgrade (Camera Settings)

1. Before adding the Profile-G camera into NVR, delete all the existing recording available in 
SD card.

2. Configure the required SD card recording configuration in the camera Webpage 

HDZ302LIW IR PTZ wiper, low light Base Firmware Version: 
V1.000.0024.0, build:

2017-10-17

PAN/TILT Firmware Version:

V1.000.000.20170914

Module Version: 01.06.0A

Camera Models Details Firmware
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Note: Irrespective of the length/size of clips, maximum number of clips supported on
SD card is 700 only. 

If user want to use secondary channels resolution for SD card recording they
have to set SD card recording settings as per the stream selected.

3. Ensure that the Camera Timezone is adjusted to match with the MAXPRONVR machines 
time zone. 

4. Select the Synchronize with check box to sync the NTP time server with Camera time 
and MAXPRO NVR time.

Upgrade MAXPRO NVR

• Install the MAXPRO NVR 4.5 Build 162 on top of NVR 4.1 Build 123. Refer MAXPRO 
NVR 4.5 Installation and Configuration Guide for more information on how to 
upgrade.

Configure the Edge Sync Settings
Edge Sync settings enables you to set the schedule for synchronizing the recordings from the 
camera SD card. This feature is supported for Profile-G compliant cameras where the 
recordings are stored at the camera level.

Note: Profile-G compliant camera time should be in sync with NVR time.

Ensure you configure the NTP server to avoid Time Sync related issues.

To configure the Edge Sync Settings:

1. In MAXPRO NVR, navigate to Configurator > Systems tab. The Systems screen is 
displayed as shown below.
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2. Under Edge Sync Settings:

• Click Every option and then select the time in minutes or hours to edge sync the 
recordings. 
            Or 
Click Every Day at option and then select the specific time in hours during which the 
edge sync should trigger. 

• Limit Past Sync: This option allows you to stop the synchronizing process at certain 
point of time. You can set time in minutes. The synchronizing process starts once it 
overshoots the limit time.

Note The default Archival Schedule configured and recommended is Every Day at 12:00 
AM. This is recommended versus the Auto [24/7] option for optimal performance and 
load on NVR.

Enable the Edge Sync
This option is supported for Profile-G compliant cameras and used for checking whether the 
camera is really Profile-G compliant. Click the Get Configuration button, if the camera is a 
Profile-G compliant camera then the Get Configuration button disappears and Enable Edge 
Sync check box is enabled. 

To enable the Edge sync option:

1. Navigate to Configurator > Camera tab. The Camera screen is displayed as shown 
below.
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2. Click the Get Configuration button. If the camera is a Profile-G compliant camera then 
the Get Configuration button disappears and Enable Edge Sync check box is enabled 
as shown below.
If the camera is not Profile-G compliant then NVR application displays Edge Sync not 
supported or enabled for this device message at the bottom of the screen.

Note: For Profile-G compliant cameras the Streaming Mode is defaulted to UDP. If you
want to switch from UDP to TCP mode then you need to update the .config file.
After modifying the .config file for TCP mode you need to restart the Trinitybackfill
service.

3. Select the Enable Edge Sync check box and then click Save.

4. Under Schedule tab > Recording Settings, select None from the drop-down list for 
both Continuous and Event based recording for the camera as shown below.
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Once the Edge syncing is enabled you can see the recordings available in SD card and in 
MAXPRO NVR (after Edge syncing) as highlighted below:

Note: You can Playback only the Edge synced clips (synced clips from camera SD card
to MAXPRO NVR) from the MAXPRO NVR clients.



M O N I T O R I N G  A  S I T E
How to Enable Low Bandwidth Streaming from MAXPRO NVR cameras to MAXPRO VMS

90  MAXPRO NVR 5.0 Operator’s Guide

3

How to Enable Low Bandwidth Streaming 
from MAXPRO NVR cameras to MAXPRO 
VMS

1. In MAXPRO NVR > Configurator> Camera > Primary Stream tab, click Add Stream to 
add a secondary stream for the camera as highlighted below. A new stream (Stream 2) is 
added.

2. Under Stream2 > Recording > Video Quality Setting, select the low Resolution, FPS 
and GOP from the corresponding drop-down lists as highlighted below.

3. Under General tab > Preferences > Stream Preference Settings, select Stream 2 from 
the Low Resolution drop-down list to set the Low Resolution configuration to use 
Secondary stream as shown below. 
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4. Once you are done with the configuration in NVR, discover the same MAXPRO NVR 
recorder in the MAXPRO VMS Server.

5. In MAXPRO VMS Client, click the Preferences Tab and navigate to Advanced settings 
tab. This tab allows you can configure to use necessary setting applicable for this client 
as highlighted below.

6. Under Low bandwidth Stream Settings: 

• Select Low Resolution Stream check box - To enable and use only low resolution 
stream from MAXPRO NVR.

• Select Receive only I Frames check box - It allows you to receive only I frames for 
the camera stream. (For example: If a Camera is configured with 5 FPS and 5 GOP 
and if you select this check box then this setting will pull only I frame for the camera 
stream. It excludes P frames for the camera stream. This setting can be used when 
the available bandwidth is too low for full frames rendering of Secondary streams.)

• Select the Use Extended Timeouts check box - This helps in increasing the default 
time outs for NVR connections, stream connections and snapshots retrieval.
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Note: These settings can be enabled and used in Winmag machines where VMS clients
are installed. After using these setting low streams can be pulled from Winmag
viewer as well.

Enable Recording During On Demand Streaming 
This feature helps user to enable recording during on demand video streaming. Earlier only 
live video was supported.

1. Log on to MAXPRO NVR.

2. Navigate to Configurator > System tab.

3. Select Enable On Demand Stream check box as highlighted below.

4. Click Save. A message id displayed as shown below.

Note: If you enable On Demand Stream feature in Systems tab then it will be enabled
for all the camera in NVR. If you want to disable On Demand Stream feature for
the required camera then go to required camera settings > Preferences tab and
then clear the On Demand Stream check box as shown below. Click Save once
done.
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Privacy Protection Settings (GDPR Favored)

Anonymization
Anonymization feature is to help the business owner to meet the EU GDPR compliance 
standards easily. The objective of this feature is to hide the identifiable personal data or 
personal identity in a video surveillance system using masking techniques. This feature is 
specific to European union region and valid license is required to enable this feature. Only an 
Administrator can use this feature and grant access in User tab. EquIP Series cameras are 
supported for this feature. 

The following Camera association and type of masking is supported:

• Blur

• Pixelize

Four Eye Authentication
This feature is also part of Privacy Protection setting and to meet the EU GDPR compliance 
standards easily. This feature is to restrict all users in a surveillance system to perform 
Playback operation. While performing playback operation at least two people from different 
roles should authenticate. For an Administrator, user authentication is not required and can do 
any playback operation. 

For an operator user, a popup is displayed and an Administrator user or any other User with 
different role needs to authenticate to perform playback operation. By default this option is not 
selected. User need to obtain valid license to enable this feature.

The following table explains the Four eye authentication based on the user and roles:

Clip Export Option

Clip export with Anonymization is supported: Anonymization feature is supported in both 
Playback and Clip Export operation. Refer MAXPRO NVR Operator’s Guide on how to export 
a clip. 

Note:  If a user exports a Anonymized clip then only WMV format is supported.

Licensing
Both Anonymization and Four Eye Authentication (GDPR Favored) features are license based. 
Contact Honeywell Tech support, see the back cover for contact information.

User Authenticating User Valid 
Authentication

Operator Administrator Or any other user 
with different role

Yes

Operator Operator No

Operator Operator 2 Yes
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Once the license is enabled the entries for both the features are displayed in License  
Management Console > Privileges screen as shown below.

Figure 3-35    License Privacy protection Settings

How to enable Anonymization

At System Level

Note: Only Administrator can use this feature and provide access to an operator.

1. In Configurator > System tab, navigate to Privacy Protection Setting tab.

2. From the Anonymization type drop down, select the masking type. The available options 
are:

• Blur: Blurs the Identifiable object

• Pixelize: Pixelizes the Identifiable object



M O N I T O R I N G  A  S I T E
Privacy Protection Settings (GDPR Favored)

96  MAXPRO NVR 5.0 Operator’s Guide

3

Figure 6-36    Privacy protection Settings

At Camera Level
At camera level user can enable or disable the Anonymization based on the requirement.

1. In Configurator > Camera tab, navigate to the camera properties for the specific 
camera.

2. Under Primary Stream > Preference tab, select the Anonymization Enabled check box 
as shown below. By default it is not selected.

Figure 6-37    Anonymization Camera Level

At  User  level
An Administrator can enable Anonymization for a specific user in Users tab. The 
corresponding user will be able to view only anonymized video.

1. Navigate to Configurator > User tab.

2. For the required User, select the Anonymization check box as shown below. By default it 
is Enabled for all the operators.

Figure 6-38    Anonymization at USer level
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How to view Anonymized video

• An Administrator should have grant permission to an operator to view the 
Anonymized video.

• After selecting the type of Anonymization from the drop down, drag and drop the 
required camera on to the video panel. Following images displays the types of 
anonymization.

For Blur

Figure 6-39    Blur View
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For Pixelize

Figure 6-40    Pixelize View

How to enable Four Eye Authentication
1. Under Configurator > System tab, navigate to Privacy Protection Setting tab.

2. Select the Enable Four Eye Authentication check box as show below.

Note: Once this option is enabled it will be applicable to entire NVR system. By default
this check box is not selected. User need to obtain valid license to enable this
feature

Figure 6-41    Enable Four Eye 
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How Four Eye Authentication feature Works

For an Non Administrator user

1. When an Non Administrator user tries to perform a playback operation then the following 
dialog box appears on th screen.

Figure 6-42    Four Eye Authentication

2. Enter the credentials of Administrator user or a User from different role.

Note: For authentication, the logged in user and the Administrator user should not be of
same role.

The following table explains the Four eye authentication based on the user and roles

3. Click the Authenticate button to view the playback video. After authentication the Four 
eye authenticated user and logged in user icons are displayed on the top of the screen as 
highlighted below. For example: In the below image for a test1 user, an administrator 
authenticates and the corresponding users are created.

• Until the four eye authenticated user is logged in, the operator can perform any 
playback operation.

User Authenticating User Valid 
Authentication

Operator Administrator Or any other user 
with different role

Yes

Operator Operator No

Operator Operator 2 Yes
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Figure 3-43    Four Eye Authentication Success

• If the four eye authenticated user logs off as highlighted below then again for any 
playback operation the Admin authentication is required.

Figure 6-44    Authenticating User
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Searching Recorded Video in 
MAXPRO NVR

Overview

You can search for video recorded from cameras connected to MAXPRO NVR. You can filter 
the search for recorded video based on search conditions like video recorded today, 
yesterday, and others.

How to search for recorder video and 
events

1. Click the Search tab. By default MAXPRO NVR is displayed under Recorders in the Filter 
window as shown in Figure 4-1. 

Figure 4-1    Search tab

2. Select “Events” or “Recordings” from the Search for list.

3. The list of cameras that are connected to MAXPRO NVR are displayed under the 
Cameras section (in the Filter window). Select the check box next to the cameras from 
which the video is recorded. Select the Select all check box to select all the cameras 
(See Figure 4-2).
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Figure 4-2    Search and Filter

4. Select one of the following search conditions corresponding to Date time filter.

• Today - video recorded in MAXPRO NVR today.

• Yesterday - video recorded in MAXPRO NVR yesterday.

• Last 7 Days - video recorded in MAXPRO NVR in the last seven days.

• Last 30 Days - video recorded in MAXPRO NVR in the last 30 days.

• On - video recorded on a particular date in MAXPRO NVR. The From box to select 
the date is enabled when you select On.

• On or Before - video recorded in the MAXPRO NVR up to a particular date. The 
From box to select the date is enabled when you select On or Before.

• Between - video recorded in the MAXPRO NVR between a time duration. The From 
and To boxes are enabled when you select Between. You can select the start time 
and date in the From box. The end time and date can be selected in the To box.

5. In the Type list, select the check boxes for the events you want to include in the search 
result. Select the Select All check box to include all the events.

6. Click the  icon. The recorded video is searched based on the search conditions. The 
search results are listed in the Results window. 
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Playing Video after Searching
Drag and drop the search result from the Results window on the salvo layout. The panel 
starts displaying the recorded video.

Tip: To select more than one search result, press the CTRL key.

Deleting the Recorded Video

Caution: Deleting the recorded video from the search result also deletes it from the 
MAXPRO NVR. The Search tab and the option to delete the recorded 
video is only accessible to NVR Administrator and Supervisor roles.

1. Select the recorded video from the list of search results.

Tip: To select more than one search result, press the CTRL key.

2. Click the  icon. The recorded video is deleted from MAXPRO NVR.

Calendar Search
The Calendar Search feature helps you to search for recorded video from a particular camera. 
You can filter the search based on the month, day, hour, and minute. By default when you first 
select this feature, the recorded videos for the current month appear.

To use the Calendar Search feature

1. Click the Calendar icon on the toolbar as shown in Figure 4-3.

Figure 4-3    Clicking the Calendar icon

Or
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Right-click the camera on the salvo panel and click Calendar as shown in Figure 4-4.

Figure 4-4    Right-clicking the camera in the salvo panel

Or

Right the camera in the device tree and click Calendar as shown in Figure 4-5.

Figure 4-5    Right-clicking the camera in the device tree

The Calendar Search view displays as shown in Figure 4-6.

Figure 4-6    Calendar Search view
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Legends

Note
• By default, the monthly view of all the recordings for the current month

appear. You can see a maximum of 31 recordings, each representing a day
of the month.

• You can also change the Month view recording time in the Preferences
dialog box as shown in the following figure.

Legend Description

Indicates that there are no recordings available for the particular 
day/hour/minute.

Indicates that the recordings are available for the particular 
day/hour/minute.

indicates that there is recording for that particular time frame, and 
not exactly at that particular time stamp.
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2. You can switch to the Day, Hour and Minute views by clicking the respective option in the 
drop-down list as shown in Figure 4-7.

Figure 4-7    Switching to the day, hour, minute views by selecting from the drop-down list

Or

Move the slider to the right as shown in Figure 4-8 to switch to the Day, Hour and Minute 
views. 

Figure 4-8    Switching to the day, hour, minute views by moving the slider

Note
• If you select Day, a maximum of 24 recordings appear, each representing an

hour.
• If you select Hour, a maximum of six recordings appear, each representing a

10 minute recording of the selected hour.
• If you select Minute, a maximum of 10 recordings appear, each representing

a minute.
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Or

Alternatively, click  bottom right calender to switch to the Day, 
Hour and Minute views (see Figure 4-9).

Figure 4-9    Calender

Navigat ion Tips

• While viewing the month wise recordings, use the  and  buttons to navigate to 

the next or previous month in sequence that you are viewing.

Tip: Follow the similar procedure to view day/hour/minute wise recordings.

• At any point of time, click the Live view icon as shown in Figure 4-10 to go back to the 
Live video view.

Figure 4-10    Returning to Live Video View

Click to return to Live video view
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Options Available on the Panel
The following table lists the options available when you right click a panel in the Calendar 
Search view.

Creating Clips
You can create clips for the recorded video.

• Click the Clip Export icon on the toolbar as shown in Figure 4-11.

Figure 4-11    Creating Clips

Note: See the Creating Clips section on page 102 for more information on creating clips 
for recorded video. Only WMV format (evidence clips) clip export option is 
supported when you create clips from Calendar Search.

Preview Search
The Preview Search feature helps you to search for recorded video from a particular camera. 
Unlike Calendar search, you can only filter the search for a particular day. You also cannot 
drag and drop a camera on the preview pane.

To use the preview search

Option Description

Save Image Saves the frame displayed in the panel as an image in 
the BMP format. 

Save Image As Saves the frame displayed in the panel as an image in 
the other formats such as JPG, GIF, PNG and soon. 

Show Video Displays the video.
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1. Right-click a camera in the device tree, and then click Preview Figure 4-12.

Figure 4-12    Preview Search - Right-clicking the camera from the Device tree

Or

Right-click the panel displaying live video and click Preview Figure 4-13.

Figure 4-13    Preview Search- Right-clicking the Live Video pane

Or
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Select the desired video panel and click the Preview icon on the toolbar as shown in 
Figure 4-14. 

Figure 4-14    Preview Search - Clicking the Preview icon

A list of recordings for the particular day appear Figure 4-15.

Figure 4-15    Preview Search - Results

Note: By default, medium sized snapshots (recordings) are displayed.
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2. To view small or large snapshots, select the appropriate option from the drop-down list as 
shown in Figure 4-16.

Figure 4-16    Selecting the Large/Small options for the Snapshots

3. To change the snapshot duration, double-click it or move the slider as shown in 
Figure 4-17.

Figure 4-17    Changing the Snapshot duration

Navigat ion Tips
• At any point of time, click the Live view icon as shown in Figure 4-18 to go back to the 

Live video view.
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Figure 4-18    Returning to Live Video View

Options Available on the Panel
The following table lists the options available when you right click a panel in the Preview 
Search view.

Creating Clips
You can create clips for the recorded video.

• Click the Clip Export icon on the toolbar as shown in Figure 4-19.

Figure 4-19    Creating Clips

Option Description

Save Image Saves the frame displayed in the panel as an image in the BMP 
format. 

Save Image 
As

Saves the frame displayed in the panel as an image in the other 
formats such as JPG, GIF, PNG and so on. 

Show Video Displays the video.
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Note: See the Creating Clips section on page 102 for more information on creating clips 
for recorded video. Only the WMV format (evidence clips) clip export option is 
supported when you create clips from a Preview Search.

Intellisense Search 
The Intellisense search option makes the search of cameras simpler and easier. When a part 
of the camera name is typed in the text box, the Intellisense search displays the list of cameras 
that are connected to various recorders in the Devices window. For example, if you are 
searching for Camera 2 connected to particular recorder, then type Ca in the text box, the list 
of camera names that contain 'ca' appears.

Intellisense search also supports wild characters while searching. For example, 

• ca* — camera names that begin with 'ca' are displayed. 

• *ca — camera names that end with 'ca' are displayed. 

• *ca* — camera names that contain 'ca' are displayed. 

• ! ca — cameras that do not have 'ca' in their name are displayed. 

Select the required filter string and click on the filter button. You can toggle between the

Filter On and Off mode using the  option or right-click , and select between Filter ON 
and Filter OFF. The hot key to activate Intellisense search is F4.

SMART Motion Search
The SMART Motion Search feature allows you to search motion of an object in a recorded 
video. This feature overcomes the traditional way of searching for an object in recorded 
videos. It enables you to filter the search in recorded video based on Year, Month, Day, Hours, 
Minutes and Seconds. You can view the recordings of before and after the existence of motion 
of an object. You can perform the search on recorded video. This feature is not applicable for 
exported clips and archival recordings.

You need to configure a region of the object in the recorded video and then define the date 
and time range to search for the motion of the selected object. 

Configuring the Search criteria
1. Select the required camera panel.

2. Click the SMART Motion Search icon on the toolbar as shown in Figure 4-20.
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Figure 4-20    Clicking the SMART Motion Search icon

Or

Right-click the camera on the salvo panel and then click SMART Motion Search as shown in 
Figure 4-21.

Figure 4-21    Right-clicking the camera in the salvo panel

Or

Right-click the camera in the Device tree and click SMART Motion Search as shown in 
Figure 4-22.
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Figure 4-22    Right-clicking the camera in the device tree

The SMART Motion Search window is displayed as shown in Figure 4-23.

Figure 4-23    SMART Motion Search View

3. In the Step 1: Configure Search Region, click the Add button to create region(s) for 
search as shown in Figure 4-24. 
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Figure 4-24    Regions Defined

4. Select the required region to display from the Region drop-down. Available options are 
All, None or (Region 1, 2, 3 and so on). Configure the Object size threshold if required.

5. In the Step 2: Select Date & Time Range, define the start and end date/time from the 
calender.

6. In the Step 3: Search, click Search. The progress bar displays the progress of the search 
A list of recordings for the particular date and time is displayed in the lower pane as 
shown below Figure 4-25.

Tip: While the search is in progress you can cancel and modify your search criteria. Such as 
add one more region, select a different date and time. You can also refresh the image for a 
better results.

Figure 4-25    Recordings for the date and time
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Note: By default, medium sized recordings are displayed.

• To view small or large snapshots (recording), select the appropriate option from the 
drop-down list as shown in Figure 4-26.

Figure 4-26    Selecting the Large/Small options for the Recordings

Navigat ion Tips

• At any point of time, click the Live view icon as shown in Figure 4-27 to go back to 
the Live video view.

Figure 4-27    Returning to Live Video
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Options Available on the Panel
The following table lists the options available when you right click a panel in the Smart Motion 
Search view.

Note

• This is a client side feature and has no impact on NVR server. Video is 
downloaded/streamed to the client and SMART Motion search algorithm is 
executed on the client.

• For 1 hour of 1080p video, it can take up to 10 minutes.
• Include regions are supported in ROI.
• Multiple clients can be used simultaneously for different camera search.

Option Description

Save Image Saves the frame displayed in the panel as an image in the BMP 
format. 

Save Image 
As

Saves the frame displayed in the panel as an image in the other 
formats such as JPG, GIF, PNG and so on. 

Show Video Displays the video.
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5
Generating Reports

In this chapter...

Overview

You can generate two types of reports: Event History report and Operator Log report.

Event History Report
The event history report can be generated for cameras and recorders. The event history report 
lists the events related to a device during a time period. For example, for a camera, you can 
generate the event history report to know the occurrence of events like enabling of camera 
motion detection, starting of background recording, and others. You can select the device and 
list of events that you want to view while generating the report.

Operator Log Report
The operator log report can be generated to view the activities performed by users. The 
operator log report lists the activities performed by users during a time period. For example, 
creating clips, adding bookmarks, and other actions performed by a user. You can select the 
users and the list of activities you want to view while generating the report.

Section See page...
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Viewing, Printing, and Saving the Report 117
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Generating the Event History Report

1. Click the Report tab.

2. In the Reports window, select the Event History Report. 

3. Click Show Report. The Event History Report dialog box appears Figure 5-1.

Figure 5-1    Event History Report

4. In the Date box, select the date for which you want to view the list of events. The following 
table lists the options in the Date box:

5. Select the Site. 

6. In the Device Types box, select the check box next to the type of device for which you 
want to generate the event history report. You can select more than one type of device. 
You can select the Select all check box to select all the device types. Based on the 
selection in the Device Type box, the list of devices appear in the Devices box. For 
example, if you have selected Video Inputs in the Device Types box, all the camera 
names appear in the Devices box.

Option Description

Today Event history report for today's events.

Yesterday Event history report for yesterday's events.

Last 7 days Event history report for the last seven day's events.

Custom Date Range Event history report between a start date and end date. The 
From and To boxes under Custom Date Range are 
enabled when you select this option. You can select the 
start date in the From box and the end date in the To box. 
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7. Under Custom Events, select the IO Alarms check box to include the input and output 
alarms.

8. In the Devices box, select the device for which you want to generate the event history 
report. The selected devices appear in the Selected Devices box. 

To select a device 

Select the check box next to the device name and click . You can 
select
more than one device. To select all the devices in the Devices box, click 

.

To remove a device 

Select the check box next to the device name and click . You can 
select
more than one device. To remove all the devices in the Selected Devices box, 
click .

9. In the Events box, select the events that you want to include in the event history report. 
The selected events appear in the Selected Events box.

To select a device 

Select the check box next to the event name and click . You can 
select
more than one event. To select all the events in the Events box, click 

.
To select a device 

Select the check box next to the event name and click . You can 
select
more than one event. To select all the events in the Selected Events box, click 

.
10. In the Event Severity list, select the severity of the event.

11. Click Generate Report. The event history report is generated and appears in the display 
area. 
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Generating the Operator Log Report

1. Click the Report tab.

2. In the Reports window, select the Operator Log Report. 

3. Click Show Report. The Operator Log Report dialog box appears Figure 5-2.

Figure 5-2    Operator Log Report

4. In the Date box, select the date for which you want to view the list of events. The following 
table lists the options in the Date box:

5. In the Operators box, select the check box next to the operators for which you want to 
generate the operator log report. You can select the Select All check box to select all the 
operators. 

6. In the Activities box, select the check box next to the activities which you want to view in 
the operator log report. You can select the Select all check box to select all the activities.

7. In the Output type box, select the type of operator log report you want to generate. You 
can select Tabular to view the operator log report in a table or Graphical to view the 
operator log report in a graph.

8. Click Generate Report. The operator log report is generated and appears in the display 
area.

Option Description

Today Operator log report for today's events.

Yesterday Operator log report for yesterday's events.

Last 7 days Operator log report for the last seven day's events.

Custom Date Range Operator log report between a start date and end date. 
The From and To boxes under Custom Date Range are 
enabled when you select this option. You can select the 
start date in the From box and the end date in the To 
box. 
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Viewing, Printing, and Saving the Report

You can use the following options in the toolbar on top of the report:

Icon Click to...

Save the report. By default, the report is saved in Crystal Reports (.rpt) 
format. You can also save the report in Adobe Acrobat PDF (.pdf), 
Microsoft Excel (.xls), Microsoft Excel Data Only (.xls), Microsoft Word 
(.doc), and Rich Text (.rtf) formats. 

Print the report. 

Toggle the display of report names on the left of the display area. 

View the first page. 

View the previous page.

View the next page.

View the last page.

Go to a page number.

Search for text in the report.

Enlarge (zoom in) and reduce (zoom out) the report view.

Close the current view.
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6
MAXPRO NVR Web Client

In this chapter...

Introducing Web Client

The MAXPRO NVR Web Client allows you to remotely access the MAXPRO NVR server and 
perform video surveillance using a web browser such as Internet Explorer. It gives you the 
flexibility to view live video and perform the basic video surveillance functions remotely over 
the web. 

MAXPRO NVR Web client is available with MAXPRO NVR 3.1 build 65 or later version. By 
default MAXPRO NVR installs the Web client and MAXPRO Web Configurator along with the 
NVR full installation. You can use the web client once you have the NVR 3.1 build 65 or later 
version.

MAXPRO NVR Web Client functions involve the following tasks:

• Viewing the live video

• Viewing Recorded Video (Playback)

• Taking Snapshot

• Viewing Presets

Prerequisites to access MAXPRO NVR Server through Web Client
The following are the prerequisites to access the MAXPRO NVR server through Web Client.

• Silverlight: Ensure that Silverlight version 5 and above is installed on your machine. 
If you don't have the Silverlight plug-in on your machine, you can download it from 
the following Microsoft link. http://www.microsoft.com/getsilverlight/Get-
Started/Install/Default.aspx

Caution: For better security, close the browser upon logout.

Section See page...
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Note: Silverlight plug-in is not supported by Chrome version 42.x or above and
Microsoft Edge browser. For better security, close the browser upon logout.

• Web Browsers Supported on Windows Systems: Ensure that at least one of the 
following supported web browsers are installed on your PC: 

• Internet Explorer version 8 or above

• Firefox version 15.0.1 or above

• Chrome version 32.x to 41.x only.

Note MAXPRO NVR Web Client is only supported by below Web Browsers on 
Windows 10 with Silverlight plug-in installed 
• Internet Explorer version 11 or above
• Firefox version 40 or above

• Web Browsers Supported on MAC systems: Not supported.
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Logging on to MAXPRO NVR Web Client

1. Double-click the MAXPRO NVR Web Client shortcut on the desktop of NVR Server/Client 
machine 
OR
Type the URL https://<MAXPRO NVR Server IP or Machine/Computer 
name>/MAXPROWEB/ in your web browser and then press Enter. The login page 
appears Figure 6-1.

Note: <MAXPRO NVR Server IP or Computer/Machine name> needs to be replaced
by the IP address or computer/machine name (as applicable) of the MAXPRO
NVR Server machine on which both the Web Server and NVR Server are installed
by default.

Figure 6-1    MAXPRO NVR Login page

Note

• If Silverlight is not installed on your machine then a message

 is displayed. If you are using Internet connection then 
you can click the link Get Microsoft Silverlight to download the Silverlight.

• When you access the MAXPRO NVR server using the URL 
https://<MAXPRO NVR Server IP or Machine 
/Computername>/MAXPROWEB/ then the following message is displayed. 
Click Continue to this website to proceed. It is recommended to verify the 
certificate to check whether it is issued by a valid authority. Refer to MAXPRO 
NVR Installation and Configuration Guide for detailed information.
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The above message appears by default when you access the NVR server for 
the first time. Honeywell recommends you to buy a Domain Name specific 
certificate, create it and then install it. Refer to MAXPRO NVR Installation and 
Configuration Guide for detailed information.

2. Type your Username. The default user name is admin.

3. Type your Password. The default password is trinity. This is the credential of non-
windows user configured in the NVR and the default administrator credentials (Username 
and Password) which are configured in MAXPRO NVR are, admin and trinity.
Honeywell recommends to create a new NVR user in the Configurator tab and use the 
same to logon. Refer to the MAXPRO® NVR Installation and Configuration Guide. for more 
information on how to Add a user. 
By default the Start In drop-down list is selected with View Video option. 

4. Click Login. Figure 6-2 appears if your credentials are successfully validated. The name 
of the currently logged in user is displayed as admin on the top left of the page.

Figure 6-2    MAXPRO NVR Web Page -Initial View
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5. Under Live Video pane, click the MAXPRO NVR node. The list of cameras configured in 
the MAXPRO NVR server is displayed.

Note: The list of cameras displayed is based on the user or operator permissions
configured in the MAXPRO NVR Server.

Logging Off

• Click Signout on the top right corner of the page.

Caution: For better security, close the browser upon logout.

Getting to Know the Web Client Page

The web page of MAXPRO NVR Web client consists of tree-structure, floating window, and 
icons. On opening the page, you see the following: Live Video Pane and default Salvo view.

MAXPRO NVR Web Page
Figure 6-3 illustrates the MAXPRO NVR Web Page. 
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Figure 6-3    MAXPRO NVR Web Client Page-Familiarization

The following components are displayed on the screen.

Video Control Options
The toolbar that appears on top of a panel enables you to view the name of the video source 
and take snapshot for a particular video panel. The toolbar that appears on the bottom and on 
the right of a panel consists of icons that enable you to perform the following actions:

Component Description

Live Video or Camera 
Pane

Displays the list of cameras which are configured in 
MAXPRO NVR.

Configured Cameras List of configured cameras which are available to render 
video.

Note To view the list of cameras in Live video pane, you 
should configure the cameras in MAXPRO NVR. 
Refer to the MAXPRO® NVR Installation and 
Configuration Guide for Configuring the Cameras. 
The list of cameras listed is based on the user or 
operator permissions configured in the MAXPRO 
NVR.

Accessing over LAN 
or WAN

Select this check box if you want to access web client 
using LAN connection.

Clear this check box if you want to access web client 
using WAN connection.

Note By default this check box is selected when you 
login the web client page.

Salvo Layout An arrangement of panels in which video is displayed. 
Select the required layouts to view the video. The Salvo 
views can be resized. See the Resizing the Salvo section 
on page 127.

Snapshot Icon Click to take a snapshot of entire salvo layout.

Floating Window Click to display different salvo layouts and snapshot icon. 
You can select the required salvo view to view the video in 
the panel.

Close Button Click to close all the panel at once.

Icon Click to...

Set the date and time for playback. See the Viewing 
Recorded Video section on page 127.

View the live video. See the Live Video section on page 
125.

Displays a drop-down list of presets. You can select a 
preset for the camera. See the Viewing Presets section 
on page 129 and Refer to the MAXPRO® NVR 
Installation and Configuration Guide. sections for more 
information on Creating Self Signed Certificate.
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Using MAXPRO NVR Web Client Features

MAXPRO NVR Web Client features includes viewing live video, playback, taking snapshots 
and viewing presets.

Live Video
You can view live video using the option available in MAXPRO NVR web client. The panels in 
the salvo layout display video. You can select the video source from cameras on the Live 
Video pane.

To view the list of cameras in Live video pane, you should configure the cameras in MAXPRO 
NVR. Refer to the MAXPRO® NVR Installation and Configuration Guide for Configuring the 
Cameras. The list of cameras listed is based on the user or operator permissions configured 
in the MAXPRO NVR.

Display the playback settings. See the Viewing 
Recorded Video section on page 127.

View the live video while you are in playback. See the 
Viewing Recorded Video section on page 127.

Take a snapshot for the required panel. You can view 
this icon when you hover the mouse on the top of a 
panel. See the Taking a Snapshot section on page 129.

Close the required panel. You can view this icon when 
you hover the mouse on the top of a panel

Select the required salvo view to arrange the panels. 
See the Resizing the Salvo section on page 127.

Close all the panels in a salvo layout.

Icon Click to...
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To view live video

• Drag and drop the required video source from the Live video pane on a panel in the 
salvo layout Figure 6-4. 

Figure 6-4    Web Client - Live Video

Note: Anonymization is not supported in Web. If user is tries to see Anonymized video
and also camera Anonymized option is enabled then an error message “Trying to
access Anonymized Stream” is displayed.

Troubleshooting Tip
If the video is not streaming through web client then perform the below steps to reset Internet 
Explorer (browser) to default settings except user specific settings like favorites, bookmarks 
etc: 

1. In Internet Explorer navigate to Tools -> Internet Options -> Advanced tab and then 
click the Reset button. The Reset Internet Explorer Settings dialog box appears.

2. Select ‘Delete personal settings’ check box and then click the Reset button.

3. Close and then open the Internet explorer.
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Note MAXPRO NVR Web Client supports streaming quality resolution up to 
1080p. Cameras configured above 1080p resolution are not supported. If 
you drag and drop a camera configured with megapixel resolutions 
(above 1080p) then a message appears and video is not displayed as 
shown below.

You can view live video in different panels of the salvo layout. When you hover the mouse over 
a video display, a toolbar appear over the panel. The toolbar enables you to perform actions 
such as Playback, Live video, taking snapshots and viewing Presets.

Note: Each MAXPRO NVR box has a limit of 64 streams for live and a limit of 32 streams
for playback feature. Even if the same camera is opened for live in multiple web
clients then it consumes only 1 stream. Each playback function consumes 1
additional stream always.

Resizing the Salvo
You can view the salvo layout when you select the available options on the floating window 
tab. At a time, you can select one of the salvo layout .For example: If you want to view video 
from two cameras, select a salvo layout with two or more panels.

• Click the required salvo layout options available on the floating window.

Viewing Recorded Video
You can easily retrieve and view recorded video using the date and time controls in the panel 
toolbar. When you select a camera from the live video pane to view video, a toolbar appears.

Note: Each MAXPRO NVR box has a limit of 64 streams for live and a limit of 32 streams
for playback feature. Even if the same camera is opened for live in multiple web
clients then it consumes only 1 stream. Each playback function consumes 1
additional stream always.
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To play recorded video

1. Drag and drop a camera from the Live video pane into the panel.

2. Hover the mouse at the bottom of a panel over live video. A tool bar appears Figure 6-5. 

Figure 6-5    Web Client - Playback

3. Click .

4. Select the date and time in the date and time calendar box 

and then click  . The video recording is played from the selected date and time.

Note: When an Operator (non-admin) logs into the Web Client and tries to view
playback for any video then an error message “Four Eye authentication Privilege
Failure” is displayed.

Navigation Tip
At any point of time, click  to go back to the Live video view.
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Viewing Presets
Preset can be viewed in web client if the camera is a PTZ camera. To view Presets in web 
client you need to define the presets in MAXPRO NVR. To configure presets in MAXPRO NVR, 
Refer to the MAXPRO® NVR Installation and Configuration Guide for more information to 
configure the presets.

1. Hover the mouse at the bottom of a panel over live video. A tool bar appears Figure 6-6.

Figure 6-6    Web Client - Presets

2. Click  and then select the required preset from the drop-down list to 
view the configured preset.

To view Presets in web client you need to define the presets in MAXPRO NVR. Refer to the 
MAXPRO® NVR Installation and Configuration Guide for more information to configure the 
Sequence.

Taking a Snapshot

You can take snapshot of the single video panel in a salvo and also all video panels in a salvo.

Note: Snapshot feature is not supported on Mac and print screen feature in Mac can be
used alternatively.

1. Click  on the right most pane of the web page. A confirmation message appears.
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Figure 6-7    Confirmation dialog - All Salvo Views

2. Click OK to save the snapshot.

To take snapshot of the single video panel

1. Hover the mouse at the top of a panel over a live a video. A tool bar appears.

2. Click . A confirmation message appears

Figure 6-8    Confirmation dialog - Single Video Panel

3. Click OK to save the snapshot.
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Using the MAXPRO NVR Mobile 
App

In this chapter...

Introduction

The MAXPRO® NVR Mobile app allows you to connect to a MAXPRO NVR from a remote 
location. Use the app to perform common daily tasks such as:

• Configure and Logon using Touch ID (For Fingerprint recognition supported mobile 
device only). Fingerprint Authentication login is supported for both Android and IOS 
devices.

• HIS Streaming support where you can view live video if you have not installed 
valid/trusted certificate.

• One time configuration for both Local and Remote connection.
• Live video view to monitor your house, facility, customers or employees.

• Live video view to monitor your house, facility, customers or employees.

• Digital zoom in and zoom out for full screen view in landscape or portrait.

• Playback or search for recorded video by date and time.

• Take a snapshot of a live or recorded video frame and use as an image.

• Create favorite salvos (cameras up to 3x3 on tablets and 2x4 on phones per salvo).

• Perform PTZ control through Presets.

• Monitor & Manage Alarms.

Section See page...
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Enhancements in NVR 5.0 Release

• Support for New Mobile app versions

• For Android: 1.3.0 (100030004)

• For IOS: 1.3.0 (100030001)

• New Supported OS: minSDKVersion = 21

Download the FREE app at the Apple® iTunes® App Store or Google Play and search for 
MAXPRO NVR. For NVR 3.5 SP1 or older version search for: MAXPRO Mobile.

The following table explains the features available in MAXPRO NVR Apps and MAXPRO Mobile 
Apps:

Adding the MAXPRO NVR to the MAXPRO NVR Mobile app

• Refer to the MAXPRO® NVR 5.0 Installation and Configuration Guide for more 
information on How to Add MAXPRO NVR to the Mobile app.)
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Logging On
To Log on: 

1. You can Log on in two ways, Manual and Finger Print Touch ID. (Finger Print Touch ID 
logon is supported for both Android and IOS devices).

• For Manual Logon:

• In the Username field enter the name that was created for the mobile device user in 
MAXPRO NVR. Refer to the MAXPRO® NVR 4.5 Installation and Configuration 
Guide for more information on Creating Users for the MAXPRO NVR Mobile app.

• In the Password field enter the appropriate password.

• Under Connect to, ensure that your Recorder is selected or tap > to connect to a 
different recorder.

• Select the Remember User Name check box If you want the app to remember the User 
Name for your future login.

• (Only for Android Devices): Select the Validate Server Authenticity check box If 
you want to validate the server.

• Tap on Terms at the bottom of the screen to read the EULA terms and conditions.

• For Touch ID logon, see Logon using Touch ID (Fingerprint Authenticated) for 
more information.

Logon using Touch ID (F ingerpr int  Authent icated)
Touch ID logon (For Fingerprint recognition supported mobile device only): This feature is 
supported for fingerprint secured Android and IOS mobile devices. Maximum of 5 users 

Apple mobile device Android mobile device

Tap Sign In. Tap Log In.
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fingerprints can be configured per mobile device. The first login should be manual login and 
you need to enter the credentials manually. After that the succeeding logins can be based on 
fingerprint authentication. The Fingerprint authentication logon option is displayed after the 
first manual logon. You can see the fingerprint icon on the bottom left corner of the login 
screen. Touch ID logon feature is supported for both Android and IOS devices.

Refer to the MAXPRO® NVR 4.5 Installation and Configuration Guide for more information on 
How to configure Logon using Touch ID.) 

Enable HIS Streaming

HIS Streaming feature allows you to view the live video even if you dont have valid certificate 
installed on the server for secure connection. You can still view the live video frame by frame to 
ensure you are surveillance process is smooth and continuous. By default HIS Streaming 
feature is enabled in the app. This feature detects your trusted certificate status automatically 
and intimates if you are viewing live video through HIS Streaming. You can use HIS streaming 
in the following scenarios:

• if you have not installed valid/trusted certificate on the Server.
• if your trusted certificate is expired.

By default HIS Streaming is enabled in Settings screen as shown below.

Apple mobile device Android mobile device
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Adding Multiple NVR Servers
To add additional NVR on the mobile app:

Note: Maximum 20 NVR configurations are allowed.

1. Tap  on the login screen. The list of already saved NVRs under My Recorders screen
is displayed.

2. Tap . The Add Recorder screen is displayed.

3. Add the MAXPRO NVR Recorder as follows:

• In the NVR Name field, type the name (For example Demo/Site name) for the 
NVR.

• In the Local IP field, type the local IP address/Host name of the unit.

• In the Remote IP field, type the remote IP address/Host name of the unit.

• Type the Port number. The default port number is 443.

4. Repeat the step 1 through step 3 to add multiple NVR Recorders

Apple mobile device Android mobile device

Tap Save to complete adding NVR 
Recorder. 

Tap Save to complete adding NVR 
Recorder.
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Editing NVR Recorder Details
To edit the NVR Recorder details:

Apple mobile device Android mobile device

Tap . The already saved NVRs are 
displayed.

On the required NVR recorder, gently swipe 
to right-side. The Edit and Delete options 
are displayed as shown.

Tap . The already saved NVRs are 
displayed.

On the required NVR recorder, gently swipe 
to right-side. The Edit and Delete options 
are displayed as shown.
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Apple mobile device Android mobile device

Tap on Edit. The Edit Recorder screen is 
displayed.

Modify the required details.

Tap Save once you modify the details.

Tap on Edit. The Edit Recorder screen is 
displayed.

Modify the required details.

Tap Save once you modify the details.
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Deleting the Saved NVR Servers
To delete the saved NVR servers:

Apple mobile device Android mobile device

Tap . The already saved NVRs are 
displayed.

On the required NVR recorder, gently swipe 
to right-side. The Edit and Delete options 
are displayed as shown.

Tap Delete to delete the existing NVR 
server. A warning message is displayed.

Tap Yes to delete Or Tap Cancel to retain.

Tap . The already saved NVRs are 
displayed.

On the required NVR recorder, gently swipe 
to right-side. The Edit and Delete options 
are displayed as shown.

Tap Delete to delete the existing NVR 
server. A warning message is displayed.

Tap Yes to delete Or Tap Cancel to retain.
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Viewing Live Video 

The MAXPRO® NVR Mobile app features a single camera or multiple camera view. When you 
login, the live view screen displays in the default salvo view as shown below. It may take a few 
seconds for the cameras to be discovered. The cameras that were associated with the mobile 
app user (Refer to the MAXPRO® NVR Installation and Configuration Guide for more information 
on Selecting the Cameras to be viewed Remotely or Local.) are listed at the bottom in the 
Camera List panel.

Limi ta t ion wi th Pr ivacy Protect ion Set t ings
• If Anonymization is enabled in NVR application, then user will not be able to see the 

video in MAXPRO Mobile App/Web client. An error message is displayed. 
Anonymization is not supported in Web. If user is tries to see Anonymized video and 
also camera Anonymized option is enabled then an error message “Trying to access 
Anonymized Stream” is displayed.

• If Four Eye Authentication option is enabled in NVR application then user will not be 
able to view playback video in MAXPRO Mobile App/Web client. When an Operator 
(non-admin) logs into the Web Client and tries to view playback for any video then an 
error message “Four Eye authentication Privilege Failure” is displayed.



U S I N G  T H E  M A X P R O  N V R  M O B I L E  A P P
Introduction

140  MAXPRO NVR 5.0 Operator’s Guide

7

Apple mobile device Android mobile device

If you have already configured the salvo layout then 
the viewing panel displays the videos as shown 
below.

If you have already configured the salvo layout then 
the viewing panel displays the videos as shown 
below



  
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To view live video, tap on the list of cameras on the bottom of screen and then drag and drop 
a camera in to a viewing panel as shown below.

Ipad Device

In Ipad you can view 3x3 salvo and allows you to add nine cameras as shown below.

Apple mobile device Android mobile device
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Drag and dop required cameras to view the live video.

To search and view the required camera, tap on the search area and then type the camera 
name. The corresponding camera list is displayed as shown below.

Apple mobile device Android mobile device

Drag and drop the camera and then tap Done. Drag and drop the camera and then tap Done.
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Limi ta t ion in  V iewing v ideo wi th  Pr ivacy Protect ion Set t ings
• If Anonymization is enabled in NVR application then user will not be able to see the 

video in MAXPRO mobile app/Web client and an error message is displayed.
• If Four eye authentication option is enabled in NVR application then user will not be 

able to view playback video in MAXPRO mobile app/Web client

Viewing HIS Stream
By default HIS Streaming feature is enabled in the app. This feature is applicable only to view 
live video in full screen or in 1x1 salvo layout. In a multiple salvo layout by default all the 
cameras are under HIS streaming mode. Based on your certificate validation this feature 
triggers and displays the live video with a message Optimizing video by switching to HIS 
Streaming as shown below.

Apple mobile device Android mobile device

HIS Streaming Live video with a message as 
highlighted below.

Drag and drop the camera and then tap Done.
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If the HIS Streaming is not enabled in the app then the following message is displayed when 
you drag and drop a camera or try to view video in full screen. 

Creating and Viewing Salvo Views and Favorites
For a first time user, by default the New Salvo screen is displayed. Drag and drop the required 
cameras on to a viewing panel and then tap Done.

Or

Apple mobile device Android mobile device

A message displays when HIS Streaming is not 
enabled.

Drag and drop the camera and then tap Done.
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Tap  at the bottom of the screen to create a new salvo layout.

Enter the name of the Salvo view and then tap on Save as shown below. 

Note

• The salvo view is created based on the number cameras moved to viewing 
screen. For example if you drag and drop three cameras then the salvo is 
created as 2 by 2 view. But the fourth camera will be blank.

• Maximum 10 favorites can be saved. 

Apple mobile device Android mobile device
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A salvo layout is created and saved under Favorites.

To view the list of saved favorites, tap . The list of favorites are displayed as shown 
below.

Apple mobile device Android mobile device

Double tap on the name field to enter the new name.



. 
. 
. 
. 
.

U S I N G  T H E  M A X P R O  N V R  M O B I L E  A P P

Introduction

MAXPRO NVR 5.0 Operator’s Guide 147

The saved salvos are displayed at the bottom of the screen as shown below. To view the 
saved or available salvo views tap on the required icons as explained in the table.

Apple mobile device Android mobile device

Task Apple/Andriod mobile 
device

Ipad Device

To view 2X2 Salvo view Tap Tap 

To view 1X1 Salvo view Tap Tap 

To view 2x4 Salvo view Tap 

To view 3x3 Salvo View Tap 

To view in full screen 
mode

Tap 
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Ipad Device

You can view the saved salvo layouts on the left pane.

Apple mobile device Android mobile device
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Ipad Device

Tap Rename on the right hand side.

Apple mobile device Android mobile device

Tap Rename on the top of the screen If you want to 
rename the Salvo name.

Double tap on the name field to rename the salvo 
name.
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Edit the name and then tap Save.

Editing Salvo layout

To edit the existing salvo layout, tap  underneath the panel. The Edit Salvo screen is

displayed in editable format as shown below.

Drag and drop the required cameras and then tap Done.

Apple mobile device Android mobile device
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Viewing Live Video in Full Screen Mode

Double-tap on one panel in the viewing panel to view the video from that channel in full screen 
mode. To return to quad view, double-tap on the panel again.

Ipad Device

Double tap to view in full screen mode.

Or

Select a camera and then tap  at the bottom of the salvo layout.

Apple mobile device Android mobile device

Rotate your Iphone mobile to view the Full Screen mode in 
Landscape view as shown below: Rotate your Andriod mobile to view the Full Screen 

mode in Landscape view as shown below.
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Video Viewing options

Task Apple mobile device Android mobile device Ipad Device

1. To Flip the video left or 
Right.

Tap  underneath that 
panel. The video flips to 
left/right.

Tap  underneath that 
panel. The video flips to 
left/right.

Tap  underneath 
that panel. The video 
flips to left/right.

2. To Flip the video Up or 
Down:

Tap  underneath that 
panel. The video flips to 
Up/Down.

Tap  underneath that 
panel. The video flips to 
Up/down.

Tap  underneath 
that panel. The video 
flips to Up/Down.

3. To view the salvo layout 
in full screen mode 
without camera list. 

Tap  on the bottom 
right corner.

4. To view the salvo layout 
along with the camera list

Tap 
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Searching for Recorded Video and Playback

To search for recorded video from one channel on the video display:

Taking a SnapShot

Tap  under that panel.This feature is available in all the modes.

Task Apple mobile device Android mobile device Ipad Device

1. To set the search 
parameters:

Tap  underneath that

panel. The date/time wheel is 
displayed.

Tap  underneath that

panel. The date/time wheel is 
displayed.

Tap  
underneath that

panel. The date/time 
wheel is displayed.

2. To select a specific 
date:

Swipe the date wheel downwards Swipe downwards on the area 
of date.

Swipe the date wheel 
downwards.

3. To select a specific 
time:

Swipe the hour and AM/PM 
wheels downwards.

Swipe the hour, minute and 
AM/PM wheels downwards.

Swipe the hour and 
AM/PM wheels 
downwards.

4. To play back the 
video starting from 
the date and time 
selected:

a. Tap Jump under the wheel. 

b. Tap Cancel to turn off the 
date/time wheel.

Tap Done. a. Tap Jump under 
the wheel. 

b. Tap Cancel to turn 
off the date/time 
wheel.
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Alarms
Alarms screen allows you to perform the following:

• View the Alarm and Alarm Details

• View Alarm Types

• Acknowledge Or Removing Alarms

• Acknowledge All the Alarms 

• Search the Alarms

• Share Alarms

Apple mobile device Android mobile device
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Viewing the Alarms and Alarm Details

In any salvo view, tap on the Viewer menu. All the menu options are displayed. Tap Alarms. 
The Alarms screen displays. By default all the alarms of the configured cameras are displayed. 
Minimum of 50 alarms are displayed.

Double tap on the required alarm. The Alarm Details screen is displayed with the details.

If you want to acknowledge then tap Acknowledge
Or 
If you want to remove then, tap Remove to remove the alarm from the list.

To go back to the list of alarms screen, tap .

Note: Acknowledge alarm performs the same operation as acknowledging an alarm 
from desktop client. Remove alarm only removes the alarm from the list in the 
mobile app and does not clear the alarm from the desktop client.

Apple mobile device Android mobile device



. 
. 
. 
. 
.

U S I N G  T H E  M A X P R O  N V R  M O B I L E  A P P

Introduction

MAXPRO NVR 5.0 Operator’s Guide 157

Ipad Device

Tap on the required alarm to view the details in the right pane.

If you want to acknowledge then tap Acknowledge. A confirmation message appears. Tap 
Yes. OR
If you want to remove then, tap Remove to remove the alarm from the list. A confirmation 
message appears. Tap Yes

Apple mobile device Android mobile device
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Filtering Alarm Types

Tap on the top most area of Alarms as highlighted below. The Alarm Types screen is displayed 
with All, Acknowledged and Unacknowledged alarms.

Tap on the required tab to view the specific alarms.

Acknowledging or Removing Alarms

To acknowledge or remove the alarms:

On a specific alarm, swipe to the right side gently until you see Acknowledge and then leave 
the control as shown below.

Apple mobile device Android mobile device
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Ipad Device

Apple mobile device Android mobile device
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Ipad Device

Tap Ok to acknowledge.

Apple mobile device Android mobile device

A Confirmation message appears. Tap OK to 
acknowledge.

A Warning message appears. Tap Yes to 
acknowledge.
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To remove an alarm:

On a specific alarm, swipe long to the right side gently until you see Remove and then leave 
the control as shown below.

Ipad Device

Apple mobile device Android mobile device

Swipe long to right-side to remove. Swipe long to right-side to remove.
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Ipad Device

Tap Ok to remove.

Apple mobile device Android mobile device

A Confirmation message appears. Tap OK to 
remove.

A Warning message appears. Tap Yes to remove.
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To acknowledge all the Alarms at once:

Note: By default only 50 alarms are displayed in the list and are appended based on 
the users interaction.

Apple mobile device Android mobile device

Drag down from the top of the list until you see 
Release to acknowledge all the alarms and then 
release the control.

Tap . The Acknowledge All option is 
displayed. Tap Acknowledge All.

Tip: To refresh the alarm list, drag down and release 
the control from the top of the list. A refresh icon is 
displayed and new alarms are loaded.
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Apple mobile device Android mobile device

A Warning message appears. Tap Yes. A Warning message appears. Tap Yes.
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Searching Alarms

To search the alarms:

Apple mobile device Android mobile device

Tap on the Search box and then type the alarm 
name.

Or Define the search criteria as follows:

Tap under the required Entities to select.

Tap on the Time of the alarm.

Tap and define the type of Alarms and Events.

Tap Apply to view the alarms based on the above 
criteria. 

Tap on the Search Camera box and then type the 
alarm name.

Or Define the search criteria as follows:

Tap under the required Entities to select.

Tap on the Time of the alarm.

Tap and define the type of Events.

Tap Apply to view the alarms based on the above 
criteria.
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Sharing Alarms

To share the alarm:

Tap on the required alarm to view the details and then tap  on top right corner.

Apple mobile device Android mobile device

The list of alarms based on the search is displayed. The list of alarms based on the search criteria is 
displayed.
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Apple mobile device Android mobile device

The available options are displayed as shown.

Choose any one option based on your requirement 
and then share.

available options are displayed as shown.

Choose any one option based on your requirement 
and then share.
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